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1. Introduction 
The KSV QCM-Z500 microbalance is a computer controlled quartz crystal 
microbalance based on impedance analysis for determining the frequency (f) 
and the quality of resonance (Q) of quartz crystals in a gaseous or liquid 
environment. In other words, the QCM-Z500 microbalance is a mass sensing 
device with the ability to measure very small changes in mass on a quartz 
crystal resonator in real-time.  
 
The KSV QCM-Z500 microbalance can measure the quality factor (Q), 
dissipation (D) and different harmonics of the quartz crystal giving additional 
information on the state of the layer adsorbed to the quartz crystal surface. 
 
The KSV QCM-Z500 microbalance includes the main electronics unit with 
built-in impedance analyzer software, a measuring chamber for fluid phases, 
quartz sensor crystals with a variety of optional coatings and a Windows 
based program to control it all. A temperature control unit can be supplied if 
required.  
 
The KSV QCM Impedance Analyzer software included with this instrument 
allows the easy operation of the experiments, which can be modified to any 
needs. The data is stored on the hard drive in a database and can be 
retrieved for analysis later. The data files can easily be exported in a variety of 
formats if another data reduction software is preferred. 

1.1 Purpose of This Manual 

This manual describes all the necessary steps to get the QCM-Z500 
microbalance instrument operational, starting from the mechanical setup and 
through software installation, calibrating the instrument, making 
measurements and finally analyzing the data obtained. Please read this 
manual carefully before using the KSV QCM-Z500 microbalance and keep it 
available to ensure the maximum performance of the instrument. 

1.2 Maintenance 

The hardware of the QCM-Z500 microbalance is manufactured to the highest 
quality standards and when used properly it should yield a trouble-free use for 
a long time. There are no specific maintenance requirements or procedures 
for the instrument that can be taken in order to prevent breakdowns. If the 
instrument is set up and used as described in this manual only parts exposed 
to normal wear and tear might need to be exchanged. 
 
WARNING! The original mains cables of the instrument and the computer 
must always be used and connected to a grounded wall socket.  Ungrounded 
wall sockets may cause dangerous voltages between the instrument, the 
computer and the real ground. 
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1.3 Physical Description 

The KSV QCM-Z500 microbalance consists of the main electronics unit and a 
measurement chamber, optionally a temperature control unit as well. The 
main electronics unit is the most central part of the KSV QCM-Z500 
microbalance, it is in fact a Linux based computer with factory-installed 
software. It takes care of the communication between the measurement 
chamber and the data-collecting computer through a local area network 
connection. 
 

 
Figure 1.1: The axial measurement chamber (left) and the main electronics 
unit.  
 
The axial flow measurement chamber is the standard chamber and is 
specially designed to ensure the best performance of the instrument by 
providing a controlled environment for the quartz sensor crystal during the 
measurements. It contains a temperature loop in which the sample fluid can 
be thermostated before it flows into the actual measuring chamber or into the 
waste channel. The tubing of the temperature loop is made of Viton, see 
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section 11. Appendix A - Chemical Compatibility of Viton of this manual for 
details on the chemicals that can be used with Viton. 

1.3.1 Main Electronics Unit 

The main electronics unit is a computer that sends and receives data from the 
measurement chamber. It connects to the measurement chamber with a 3-pin 
D-connector located on its front panel. A local area network is used to connect 
to the computer running the experiment, the network cable socket is located 
on the back panel. A power supply is also necessary, both 110-120VAC and 
220-240VAC can be used but check that the fuse is on the correct setting 
before connecting to the mains (see section 3.1 Mechanical Installation).  
 

 
Figure 1.2: Connections of the QCM-Z500 microbalance main electronics 
unit. 
 
1) Fuse 4) Network connection port to 

computer (RJ-42) 
2) Power connection and On / Off 
switch 

5) Com port (RS-232, not for use 
with the TCU) 

3) Connection port to measuring 
chamber (3-pin) 

6) Reset button 

 
NB) The Com port (number 5 in figure 1.2) at the back of the main electronics 
unit is used only for loading the internal Linux program at the factory and not 
for use with the Temperature Control Unit (TCU)!  
 
At the top of the front panel there is a green LED lamp which blinks when the 
instrument is turned on whilst the internal operating system loads. This LED 
will blink for about 1 minute. When the LED light stops blinking the Linux 
operating system has been loaded and the main electronics unit is ready for 
measurements. 
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The reset button (#6 in figure 1) reboots the main electronics unit.  
 
The internal components of the QCM-Z500 main electronics unit are shown in 
figure 1.3 below. 
 

 
Figure 1.3: The internal components of the main electronics unit. 
 
1) Power switch and Fuse 6) A/D-converter card 
2) Transformer 7) Oscillator card 2 
3) Fan 8) Oscillator card 1 
4) Connection port to computer (RJ-
42) 

9) Detector card 

5) Com port (RS-232, not for use 
with the TCU) 

10) Processor board 

1.3.2 Axial Flow Measurement Chamber 

The measurement chamber is where the actual experiment takes place. There 
are several models available of which the axial flow measurement chamber is 
the standard one. Common to all is that a quartz crystal is cleaned and placed 
inside so that it rests on two electrodes. The electrodes provide alternating 
current that causes the crystal to move due to the piezoelectric effect inherent 
in quartz crystals. A fluid can flow across one side of the crystal. 
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Figure 1.4: The axial flow measurement chamber. 
 
The name of the axial flow measurement chamber comes from the way the 
fluid moves through the unit. The inlet tube is at the top of the instrument, and 
the fluid flows down through a thermostation loop to either the crystal itself in 
the measuring chamber and then out or out directly (used for cleaning the 
tubing between samples).  
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Figure 1.5: Flow direction of the sample in the axial flow measuring 
chamber.7 
 
The volume of the temperature loop is around 3 ml, and the volume needed 
for flushing the actual measuring chamber is 1 ml. The flow direction of the 
fluid is controlled by a three-way valve. All parts of it in contact with the fluid 
sample are made of acid resistant stainless steel except the o-rings holding 
the crystal sensor, the tubing used in the temperature loop and the outlets 
from the measurement chamber which are all made of Viton. The o-rings and 
tubing can be easily exchanged to another material if needed, Viton has been 
chosen because of its high resistance to organic solvents. The actual 
measuring chamber is made of Teflon (PTFE) in order to meet the chemical 
compatibility standards and for ease of cleaning. The main body of the 
measurement chamber is made of aluminum to maximum heat transfer.  
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Figure 1.6: Main components of the axial flow measuring chamber. 
 
1) Top module 5) Temperature control socket 
2) Bottom module 6) Grounding for crystal surface 

electrode 
3) 3-way valve control knob 7) Top outlet for Bypass tube 
4) Heat sink 8) Bottom outlet for Chamber tube 
 
The axial measurement chamber also includes the sample inlet and the 3-pin 
D-connector socket on the bottom module which links the measurement 
chamber to the main electronics unit. The detailed components of the top 
module (#1 in figure 1.6) of the axial flow measuring chamber are shown 
below. 
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Figure 1.7: Components of the top module of the axial flow measuring 
chamber. 
 
1) Fitting 11) 3-way valve 
2) Crystal 12) Crystal chamber body 
3) Teflon crystal holder 13) Centering pin 
4) Center tube 14) Crystal support body 
5) Knob 15) Crystal support nut 
6) Flange bearing 16) Thermostation spiral block 
7) Viton O-ring 17) Thermostation outer block 
8) Viton O-ring 18) Shaft 
9) Viton O-ring 19) Top module cover 
10) Crystal support spring-loaded 
pins 

20) Top plate 

 
The detailed components of the bottom module (#2 in figure 1.6) components 
are shown below. 
 



 
 

9 

 
 
Figure 1.8: Components of the bottom module of the axial flow measuring 
chamber. 
 
1) Circuit board module 6) Bottom plate 
2) Grounding for crystal surface 
electrode 

7) Bottom module cover 

3) Temperature control socket 8) Heat sink 
4) Peltier element 9) Bottom thermostation block 
5) Rubber feet 10) Centering pin 
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1.3.3 Parallel Flow Measurement Chamber 

The parallel flow measurement chamber is an alternative to the axial flow 
measurement chamber. The principal concept of the parallel flow 
measurement chamber is the same as that of the axial flow one, that is the 
sample flows through a chamber where the crystal is housed. The advantages 
of the parallel flow measurement chamber are the smaller size, which means 
that smaller sample volumes are required, and a window directly to the 
chamber which allows the user to monitor constantly what is actually 
happening. It is also possible to use a microscope to observe the microscopic 
changes as a sample is introduced.  
 

 
Figure 1.9: The parallel flow measurement chamber. 
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Image 1.10: The window measurement chamber. 
 
1) Glass attachment nut 
2) Glass window 
3) Large o-ring 
4) Top module 
5) Bottom module 
 
The window measurement chamber has two modules. The top module 
contains the main body of the measurement chamber, the chamber itself and 
the valve for controlling the flow direction of the sample whilst the bottom 
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module consists of the support platform for the measurement chamber, the 
heat sink, the electronics and the electrodes. 
 

 
Image 1.11: The top module. 
 
1) Lock screw 5) Valve 
2) Top module cover 6) Bypass outlet 
3) Chamber support stage 7) Chamber outlet 
4) Feed 8) Chamber 
 
The main body of the top module is made of aluminum to maximise heat 
transfer. The internal parts of the valve are made of teflon (PTFE). The whole 
of the tubing and the o-rings are made of viton. The tubing supplied to 
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connect the sample reservoir to the valve is made of Viton as well. Please 
check that any sample or cleaning solution does not react with Viton from 
section 10. Appendix A - Chemical Compatibility of Viton, if necessary 
alternative substances are available. 
 

 
Image 1.12:The chamber support stage. 
 
The tubing loops around the aluminum support stage to maximize the heat 
transfer.  
 
The axial measurement chamber also includes the sample inlet and the 3-pin 
D-connector socket on the bottom module which links the measurement 
chamber to the main electronics unit. The detailed components of the top 
module (#1 in figure 1.6) of the axial flow measuring chamber are shown 
below. 
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1.3.4 Quartz Crystal Sensors 

The quartz crystal sensor is the heart of the instrument. The standard 
fundamental frequency of the crystals delivered with the QCM-Z500 
microbalance is 5 MHz, although crystals with up to 50 MHz can be used with 
the instrument. KSV Instruments can also provide crystals with a fundamental 
frequency of 10 MHz. The electrodes on the crystals are made of gold and 
have a keyhole configuration where the contacts for the electrodes are on the 
same side. The electrode in contact with the sample fluid is grounded and 
much larger in order to make sure that the processes taking place on the 
quartz crystal surface are as similar as possible over the entire surface. 
 
The gold surface of the electrodes can easily be modified for special 
applications or needs, for example by self-assembled monolayers, LB 
deposition, spin coating, vapor deposition etc.  
 

   
Figure 1.13: The quartz crystal electrodes and quartz crystals with different 
coatings.  
 
Apart from the standard gold-coated sensor crystals KSV Instruments can 
provide a variety of other surfaces upon request, these include: 
 
Metals: Ag, Al, Ca, Cr, Cu, Li, Mg, Ni, Sn, Pt 

Inorganic: ITO, LiF, MgF2, SiO, SiO2, TiO2, ZnS, Ti3NO 
Polymers: PANi, Teflon, PMMA, PS, PC, PE, PP, AKD 
 
The standard crystal sensor has a fundamental frequency of 5 MHz, a 
diameter of 14 mm and a gold coating. Other frequencies and coatings can be 
obtained by request.  

1.3.5 Valve operation 

The flow direction of the fluid is controlled by a three-way valve, connecting 
the sample reservoir, the waste container and the crystal chamber.  
 
The recommended procedure in operating the valve either for filling the 
chamber with a sample is to have the valve in the Stop position (marker 
pointed down) before filling the reservoir. Fill the reservoir and then turn the 
marker to the Waste position (marker pointed left). Allow a few drops to come 
out, then turn the valve anti-clockwise through the Stop position to the 
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Chamber position (marker pointed right). Again allow a few drops to come out 
and turn the valve to the Stop position again.  
 
To clean the tubing, set the valve to Cleaning (marker pointed up) and pour 
the cleaning solution into the sample reservoir. The cleaning solution will then 
flow along both tubes, be sure to do so above a sink or so that the chamber 
and the waste outlets are above a beaker 

1.3.6 Optional Temperature Control Unit  

The chambers supplied by KSV Instruments always contains a Peltier 
element, a heat sink, a temperature sensor inside the thermostation block 
parts and a fan, but in order to make use of these a separate Temperature 
Control Unit is required. 
 
The Peltier element enables heating or cooling of the thermostation block and 
hence adjusting the temperature of the measuring chamber. The temperature 
can be either set manually from the Temperature Control Unit (figure 1.10) or 
with the computer by using the KSV QCM Impedance Analyzer software. The 
useful temperature range is between +10 and +50 oC with a resolution of 
0.1oC for the axial flow measurement chamber.  
 

 
Figure 1.14: Front panel of the optional Temperature Control Unit. 
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2. Brief Instructions 
This section describes briefly the steps necessary to install the KSV QCM-
Z500, calibrate it and perform a basic measurement. However, it is strongly 
recommended that this manual is read completely and thoroughly as it 
contains valuable information on the required procedures and the working of 
the instrument. Use this section as a checklist and a reference once the actual 
procedures are familiar.  

2.1 Installation Procedure 

 Lift the KSV QCM-Z500 microbalance instrument onto a steady table. 
 Install the network card delivered with the instrument onto the 

computer.  

 Connect the power cord and the network cross-cable to the instrument. 
Plug the power cord into a grounded wall socket and connect the 
network cross-cable to the installed network card. Connect the signal 
cable between the main electronics unit and the measuring chamber. If 
a Temperature Control Unit (TCU) is used connect it to the fan, 
measurement chamber, power supply and computer (note that the TCU 
connects directly to the computer, and not to the main electronics unit).  

 Turn on the power of the main electronics unit and wait for at least 1 
minute or until the light on the front panel stops blinking. 

 Define the IP address of the installed network card as 192.168.168.1 
and the Subnet mask as 255.255.255.0 in the Windows Network 
Connections screen.  

 Install the KSV QCM Impedance Analyzer software from the software 
installation CD by running setup.exe from the root of the CD. 

 Start the KSV QCM Impedance Analyzer software by choosing 
Programs > QCMZ > QCMZ from the Windows Start menu. Check 
that the Status: bar in the software says Program ready for 
measurements. If this is not the case check the IP address of the 
network card, the address of the QCM-Z500 microbalance (should be 
192.168.168.168) from Edit > Device Parameters in the KSV QCM 
Impedance Analyzer software and that the internal program is loaded 
from File > Load Program. Also try rebooting. 

2.2 Calibration 

 From the menu bar of the KSV QCM Impedance Analyzer software 
open Controls > Calibrate. 

 Insert the appropriate information and press Calibrate. 
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 Remove the top module of the axial flow measurement chamber and 
insert the calibration tool so that the short circuit part is in line with the 
electrodes and the guidance pole goes through the appropriate hole. 
Press down gently and press OK.  

 Wait. When instructed to do so remove the calibration tool and press 
OK. 

 Wait. When instructed to do so replace the calibration tool, this time 
with the known resistance in line with the electrodes and press OK. 

2.3 Cleaning 

 Remove the top module, unscrew the nut and take away the teflon 
chamber construction and the crystal.  

 Let the cleaning and the rinsing liquids (often pure ethanol and ion-
exchanged water are acceptable) flow through the Bypass and the 
Chamber loops. 

 Wash the interior of the top module with the cleaning and the rinsing 
liquids.  

 Wash the crystal with either chromic acid or a Piranha solution, and 
rinse with ethanol and ion-exchanged water.  

 Wash the teflon chamber pieces with the cleaning and the rinsing 
liquid. 

 Replace the chamber pieces and the crystal into the top module and 
screw on the nut. Replace the top module on top of the bottom module. 

2.4 Measurement Procedure 

 Check that the valve is set on Stop and fill the reservoir with the 
background liquid (often water). Turn the valve to the Bypass setting 
and after a few drops have come out return the valve to the Stop 
position.  

 Turn the valve to the Chamber setting and after a few drops have come 
out turn the valve to Stop.  

 If a Temperature Control Unit is used, set the target temperature from 
either the unit itself or the QCM-Z500 Impedance Analyzer program at 
Controls > Temperature Controls. Wait 30 minutes for the instrument 
to reach thermal equilibrium. 
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 Click the New Experiment icon. Fill in the relevant information in the 
Experimental Setup screen. Use Edit Database to add new items on 
the drop-down menus, press Start when finished. 

 Select Automatic as the measurement Method and select all of the 
harmonics. Press Start. Wait for the frequencies of the resonances to 
settle.  

 Empty the reservoir and open the Bypass. Let the background liquid 
drain and then pour the sample to the reservoir. When a few milliliters 
of the sample have come out from the bypass switch to Stop to wait for 
thermal equilibrium. Then turn the valve to Chamber. 

 Allow a few milliliters to pass through the chamber to flush it. Close the 
valve and wait for the frequencies to stabilise. Flush with the 
background liquid again or introduce the next sample according to what 
is being measured. Press Stop when finished. 

2.5 Data Analysis and Reduction 

 Data analysis is carried out by another program called Browse 
Experiments. Open it from either the desktop (QcmBrowse) or from 
Start > Programs > QCMZ > QcmZBrowse.  

 Set the search parameters for the experiment wanted if necessary and 
select it from the Experiments box. Right-click on it and select Graph to 
view the graph of the specified harmonic. Change the variable of the x-
axis or the y-axis, or add another y-axis from the top right corner of the 
Browse Experiments window. Export a graph from Graph > Show 
Menu > Export. 

 Export data either by pressing the Copy to Clipboard icon and pasting 
in another program (e.g. Notepad in order to save the data in ASCII 
format) or by selecting File > Export/Delete Data. Send the 
experiments to be exported to the Destination List and press Export. 
The file created is only useable by a KSV QCM-Z500 Impedance 
Analyzer program, use this feature to make backups or to transfer the 
data to another computer with the software. Import an experiment file 
from File > Import Data.  
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3. Installation 

3.1 Mechanical Installation 

The KSV QCM-Z500 instrument is delivered in one crate. The crate should be 
opened carefully and checked to see that it contains the following items: 

 Main electronics unit 

 Standard axial flow measuring chamber 

 Calibration tool 

 5 gold coated quartz crystals 

 Network card 

 Power cord 

 Network cross-cable 

 Signal cable between the main electronics unit and the axial-flow 
measuring chamber 

 Software and manual on CD 

Unwrap the plastics around the unit and place the QCM-Z500 on a steady 
table, preferably with running clean (ion-exchanged) water nearby.  
 
The KSV QCM-Z500 microbalance has an internal computer running a Linux 
operating system for taking care or the basic calculations during 
measurements and communications between the instrument and computer. 
The communication between the computer and the QCM-Z500 microbalance 
is carried out by a local network connection. This means that the computer 
used with the instrument needs to have a network card installed solely for the 
QCM-Z500 microbalance, and if the network card was already in use (for 
example to connect to the internet or an intranet) another one needs to be 
added. One is provided with the instrument. 
 
The QCM-Z500 microbalance has been fitted with an IP address which is 
192.168.168.168 . It can be changed but to do so please contact KSV 
Instruments directly.   

3.1.1 Installing the Network Card 

Shut down the computer and open the cover of the computer's central unit. 
Find a free PCI slot and put the network card delivered with the instrument in 
this slot. Remember to attach the network card properly so that it cannot move 
in its slot. Start the computer, preferably with Windows 2000 or XP. Windows 
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will automatically install the network card and no drivers are needed. 
However, if it cannot be automatically installed (especially common with older 
versions of Windows) Windows will ask for drivers for the network card. 
Please insert the diskette or CD-ROM from the network card box and direct 
Windows to this media if that should happen.  

3.1.2 Connecting Cables 

The cables used with the KSV QCM-Z500 microbalance have been chosen so 
that no incorrect connections can be made. Before plugging in the power 
supply check whether the fuse (number 1 on Figure 2 of 1.3 Physical 
Description) is in the correct setting. Two different voltage ranges are 
available, 100-120VAC and 220-240VAC. Look at the text at the bottom of the 
fuse next to the arrow pointing down, this indicates which voltage setting is 
currently in use. To change to the other setting remove the fuse, turn it so that 
the supplied voltage is indicated on the bottom and reattach it.  
 

 
Figure 3.1: Removing the fuse. 

A) Power Supply 

Plug in the power cord to the backside of the main electronics unit (#2 in 
figure 2 in section 1.3 Physical Description). For safety reasons always use 
grounded wall sockets for the power supply. If the Temperature Control Unit is 
available then also connect a power cord to the backside of the unit (see 
Figure 8 in section 1.3 Physical Description).  

B) Measurement Chamber Communication 
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Connect the 3-pin signal cable between the 3-pin D-connector on the front 
side of the main electronics unit (#3 in Figure 2 in section 1.3 Physical 
Description) and the 3-pin D-connector on the front side of the standard axial 
flow measuring chamber (#9 in Figure 4 in section 1.3 Physical Description). 
The 3-pin D-connectors can only be connected one way, though if enough 
force is applied it is possible to attach them in the wrong way. Please avoid 
doing so. Remember to tighten the screws on the plugs to avoid accidentally 
removing the cable.  
 

 
Figure 3.2: The connector cable between the main electronics unit and the 
measurement chamber. 

C) Network Cable 

As this is a connection between two computers a cross network cable is 
required. Attach it to the RJ-42 connector (#4 in Figure 2 in section 1.3 
Physical Description) on the backside of the main electronics unit and then 
to the network card on the computer.  
 

 
Figure 3.3: The back of the main electronics unit. 
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D) Optional Temperature Control Cable 

If the optional Temperature Control Unit (TCU) is available then two cables 
need to be connected from the TCU to the measurement chamber. These 
cables are ready connected to the TCU at the factory, the red cable connects 
to the bottom module of the chamber (#7 Figure 4 in section 1.3 Physical 
Description for the standard axial flow measurement chamber) and the black 
cable connects to the fan. The red cable receives the temperature reading 
from the thermometer in the module and controls the Peltier element while the 
black cable controls the fan.  
 

 

 
Figure 3.4: Connecting the Temperature Control Unit to the measurement 
chamber.  

3.2 Software Installation  

3.2.1 Setting Up a Local Area Network Connection 

The QCM-Z500 microbalance is directly connected to the PC through a local 
area network connection. In order for the communication to work properly the 
local area network parameters for the installed network card should be set in 
Windows according to the instructions below. 
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Make sure that the network card is installed in the computer and connected to 
the QCM with the cross network cable as explained in section 3.1 Mechanical 
Installation. Turn on the power of the main electronics unit and wait for about 
1 minute for the internal Linux operating system to load. The green light on the 
top of the front panel stops blinking once the main electronics unit is ready.  
 
Open Network Connections from the Control Panel. The exact location 
depends on the version of Windows used, the Control Panel can usually be 
found from the Start menu. In the Control Panel the icon Network 
Connections exists either separately or under Network and Internet 
Connections > Network Connections. 
 

 
Figure 3.5: The Network Connections window. 
 
Double-click on Local Area Connection.  
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Figure 3.6: The Local Area Connection Status window. 

Press Properties.  
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Figure 3.7: The Local Area Connection Properties window. 

Select Internet Protocol (TCP/IP) and press Properties.  
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Figure 3.8: The Internet Protocol Properties window. 
 
Select Use the following IP address option and fill in the IP address 
192.168.168.1 and Subnet mask 255.255.255.0 as shown above. Press OK. 
 
The communication path between the QCM-Z500 instrument and PC has now 
been defined. Sometimes it is necessary to restart the computer and the 
QCM-Z500 microbalance before the connection is activated. 
 
NB! It is also possible to connect the QCM-Z500 microbalance directly to a 
larger internal local area network (intranet). In such cases the QCM should 
have an individual IP address reserved for it so that it can be connected to the 
larger network in the same way as any other computer. This IP address is 
then programmed into the QCM-Z500 microbalance by KSV Instruments in 
cooperation with a local computer support person either before shipping or on-
site during installation and training. However, the procedure for setting up this 
kind of connection is not described here. 

3.2.2 Installing KSV QCM Impedance Analyzer Software 

The KSV QCM Impedance Analyzer software is available on the CD-ROM 
delivered with the instrument. Insert the CD and open My Computer. Find the 
CD drive (D:\ on most computers) and open it. Double click on the file 
setup.exe.  
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The installation program begins with this window. Press Next to continue. 
 

 
 
Fill in the Name and Company fields, and press Next. 
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To change the installation directory press Browse, otherwise press Next to 
continue. 
 

 
 
To change the folder name in the Start menu type it into the Program 
Folders field, otherwise press Next to continue. 
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Press Next to continue. 
 

 
 
Wait for the installation to complete itself.  
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Press Finish to complete the software installation process. To create a 
shortcut to the QCM program open My Computer and select the folder to 
which the QCM software was installed (by default C:\Program 
Files\KSV\QCMZ). Right-click on the file QCM.exe and select Send To > 
Desktop (create shortcut) from the drop-down menu.  
 
To start the program either double-click on the shortcut on the desktop or from 
the Start menu at Start > Programs > QCMZ > QCMZ. This opens the main 
menu of the KSV QCM Impedance Analyzer software. 

3.2.3 Checking Software Installation and Communication 

First turn on the power of the main electronics unit and let it load its internal 
programs for ca. 1 minute (once loaded the blinking green light changes to a 
steady green light). Start the software by double-clicking on the QCM shortcut 
on the desktop or choose Start > Program > QCMZ > QCMZ from the Start 
menu. If the connection between the main electronics unit and the computer is 
working the Status: field in the lower right corner will state that the instrument 
is Ready for a new Experiment. 
 

 
Figure 3.9: The QCM Impedance Analyzer main window.   
 
If this is the case then the instrument needs to be calibrated before 
measurements can be performed. The calibration procedure is described in 
section 3.3 Calibration below. However, if the main electronics unit is not 
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turned on, the IP address in the KSV QCM Impedance Analyzer software for 
the QCM-Z500 microbalance is not correctly defined or there is a problem with 
the cables connecting the main electronics unit to the computer the following 
window will appear: 
 

 
Figure 3.10: The Error! message. 
 
If this window appears check that the power is turned on and then press OK 
to continue. In the main menu if the Status: field says Program not loaded 
for QCM unit then first try to close and restart the program. If the problem 
persists then try the following, though do not hesitate to contact your local 
distributor or KSV directly. Often with Windows based programs a problem 
can be fixed by restarting the computer so that should be attempted as well.  
 

 Check that the green light on the top of the front panel of the main 
electronics unit is on and that it is not blinking. If it is not on check the 
power cable for the unit and check that the switch in the back of the 
unit is in the "on" position, that is with the I pushed towards the unit and 
O sticking out. If the light is blinking the processor inside the unit is still 
starting up (like turning on the computer it takes time) and wait for it to 
stop blinking. This should take about a minute. 

 Check the IP address in the local area network connection by repeating 
the steps described in section 3.2.1 Setting Up a Local Area Network 
Connection. Make sure that the IP address is defined as 
192.168.168.1 and that the Subnet mask is 255.255.255.0. 

 Check the cable connecting the main electronics unit to the computer. 
Do this for example by removing the network cable from another 
computer connected to the internet or an intranet and replacing it with 
the one connecting the unit and the computer. If the connection works 
then reconnect the cable and try restarting the software. 

 Check the IP address in the KSV QCM Impedance Analyzer software. 
Do this by selecting Edit > Device Parameters from the main menu.  

 Check that the IP address is 192.168.168.168. If necessary the last 
three digits can be altered as long as they do not match the IP address 
of the local area network connection. Press OK and restart the 
software.  
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Figure 3.11: Device Parameters. Indicate which measurement chamber is 
connected and whether a Temperature Control Unit is available. 
 

 Check if the internal program for the QCM is loaded. Select File > 
Load Program from the main menu. If the text field says Done that 
means that the internal QCM software has been successfully loaded. If 
the field is empty press Load Code to attempt to load the program 
manually. This will only work if the connection between the main 
electronics unit and the computer is working.   

 

 
Figure 3.12: Load. If the field is empty press Load Code and wait for the text 
Done to appear. 
 

 Check if the connection between the main electronics unit and the 
computer is working. After loading the code successfully select File > 
Connect from the main menu. Press Connect Qcm if no text is visible. 
If the connection is working the following text will appear “Looking up 
qcm host, Connecting…, Connected, Hello from QCM. Ready to 
rock´n roll” will appear. 
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Figure 3.13: FormIPClient. Check the connection to the QCM, receiving the 
above message indicates that the connection is fine. 
 

3.3 Calibration 

After installing the software and checking that the KSV QCM Impedance 
Analyzer software and the QCM-Z500 microbalance instrument are 
communicating with the computer the instrument has to be calibrated. Each 
measurement chamber type has to be individually calibrated, and the 
following procedure applies to all chambers. The calibration is done in 3 steps, 
with a short circuit, an open circuit and a known resistance. Select Controls > 
Calibrate from the main menu window to open the Calibration controls 
window. 
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Figure 3.14: Calibration controls. Select the measurement chamber available 
and press Calibrate. 
 
If an alternative measurement chamber is in use indicate so in the 
Measurement chamber box. With a new chamber remember to add it to the 
database first, select Edit > Database or see section 6. The Database for 
details. In the Calibration Parameters box fill in the values for the fundamental 
frequency F0 (usually 5 MHz), the bandwidth BW (usually 2 MHz) and the 
known resistance R (usually 100 Ohm).  
 
In most circumstances the harmonics are very useful so it is advisable that the 
11th harmonic is chosen in the Last harmonic included box. Press Calibrate 
to begin the calibration. 

 

 
Figure 3.15: Calibration instructions, phase 1. 
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Lift the top module away from the standard axial measurement chamber to 
expose the electrodes. Insert the calibration tool so that the short circuit part 
of it is in line with the electrodes and the guidance pole goes through the 
designated hole on the tool. Press the calibration tool down gently and press 
OK.  
 

 
Figure 3.16: The calibration tool. 
 
The mouse cursor changes to show an hourglass. After a while (even up to 1 
minute) the following window will appear. 
 

 
Figure 3.17: Calibration instructions, phase 2. 
 
Remove the calibration tool from the measuring chamber and press OK.  
 

 
Figure 3.18: Calibration instructions, phase 3. 
 
Wait until this window opens. Replace the calibration tool into the 
measurement chamber, this time with the known resistance part in line with 
the electrodes. Press the calibration tool down gently and press OK 
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Figure 3.19: Calibration complete. 
 
Calibration has been completed, press OK to start making measurements with 
this chamber. 
 
Calibration of the QCM-Z500 microbalance should only be necessary the first 
time the instrument is installed. However it is recommended that the 
instrument is recalibrated every 6 months and each time the instrument is 
moved, even from table to table. 
 
The calibration of the instrument can easily be checked by selecting Controls 
> Test from the main menu. 
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Figure 3.20: Test Controls. Select the test conditions and press Start. 
 
Press Start to see the impedance and phase curve as a function of frequency. 
By placing the calibration tool in the shortcut orientation impedance should 
show a value close to zero, while changing to the resistance orientation of the 
calibration tool should show an impedance value of the known resistance 
(usually 100 Ohm). If this is the case the instrument calibration is fine, if not 
then it is recommended to recalibrate the instrument.  
 
For more information on the Test Controls screen please see section 7. 
Testing and Troubleshooting. 
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4. Measurement 

4.1 Overview 

Once the QCM-Z500 microbalance instrument has been installed and the 
communication between the instrument and the computer is established the 
instrument is ready to make measurements. Using the QCM-Z500 
microbalance is straight forward, but there are certain steps that have to be 
done in order to obtain good and reproducible results and those are: cleaning 
the measuring chamber, cleaning the quartz crystal, assembling the 
measurement chamber, preparing the samples, filling the flow system and 
measuring chamber with a background liquid, starting the software and 
collecting the datapoints. 
 
Each step is described in detail below in order to guide the user through 
making a complete measurement. It is advisable to make the first 
measurements with either pure liquids or a series of glycerol solutions in order 
to get a feeling for the instrument before starting with the actual 
measurements.  
 
The KSV QCM Impedance Analyzer software is an easy to use Windows 
based program capable of being used for various types of experiments, to log 
data with real-time graphing and to review results from previous experiments.  
 
The software should be used with Windows 2000 or XP operating systems. 
Experimental data is stored directly to the hard drive in a single database 
library during an experiment. To access previous measurements an additional 
program, the Browse Experiments, is available. Through it specific 
measurements can be found by searching with the user name, file name, 
substance used or date of the experiment. Data can be exported as an image 
of the graph, as comma or tab delimited lists for use with a spreadsheet 
program or in ASCII format.  

4.2 Cleaning the Quartz Crystal 

Much of the stability and reproducibility of measurements made with the QCM 
depend on how well the crystal has been cleaned before use. There are 
several well-known cleaning procedures for quartz crystals and these can 
easily be found in literature. Here are 3 ways of cleaning the crystal: 

 Place the crystal in a Piranha solution (1:3 H2O2:H2SO4) for a couple of 
minutes and rinse the crystal afterwards thoroughly with ion exchanged 
water. Dry the crystal by blowing with nitrogen or use an aspirator to 
suck it dry. Warning! Piranha solution is very corrosive and utmost 
care should be taken and proper protective clothing should be used 
when handling it. 
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 Bring a 1:1:5 solution of H2O:H2O2:NH3OH to boil and place the crystal 
in it for about 5 minutes. Dry the crystal by blowing with nitrogen or use 
an aspirator to suck it dry.  

 Leave the crystal inside a UV-ozone cleaning chamber for about 10 
minutes. This method is very effective against organic contaminants. 
The crystal is ready to use straight from the chamber with no rinsing or 
drying necessary.  

 
Figure 4.1: Sucking the crystal dry. 
 
After any of these cleaning procedures the crystal can be used for 
measurements immediately.  

4.3 Cleaning the Axial Flow Measuring Chamber 

In order to have stable and reproducible measurements it is necessary to use 
a good cleaning procedure for the measuring chamber, i.e. its flow system 
and the parts in contact with the sample fluids. The cleaning of the flow 
system and the measuring chamber parts is therefore recommended before 
and immediately after each measurement.  
 
The standard axial flow measurement chamber usually requires a rinse of the 
flow system and the measuring chamber parts with extensive amount of 
ethanol followed by ion-exchanged water to be sufficiently clean. However it 
might be necessary to use other liquids for cleaning, and finding the 
appropriate way of cleaning depends largely on the type of experiments so 
proper cleaning procedures develop by experience. 
 
Here is the recommended method for cleaning the axial flow measuring 
chamber: 
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1. Lift the top module separate from the bottom module and take it to a 
sink. Set it down upside-down, unscrew the crystal support nut and 
remove all of the teflon chamber parts and the guidance pole. 

 
Figure 4.2: Separating the top module of the axial flow measurement 
chamber. 

2. Set the top module upright again, turn the valve to the Chamber 
position, fill the reservoir with an appropriate cleaning solution and let 
the liquid pass through the flow system. Repeat this for each cleaning 
and rinsing solution (often pure ethanol and ion exchanged water are 
enough) at least 3 times. 

3. Turn the valve to the Stop position and turn the top module of the axial 
flow measuring chamber upside down so that the crystal chamber body 
is upwards. Rinse the inner compartment of the crystal chamber body 
first with the cleaning solution and then with the rinsing solution. 

4. Dry the flow system and the inner compartment of the crystal chamber 
body either by using an aspirator or by blowing nitrogen through the 
system. 

5. Clean the 2 Viton o-rings and the teflon crystal holder with appropriate 
cleaning and rinsing solutions. 
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Figure 4.3: The crystal support nut, o-rings, teflon chamber, crystal and 
guidance pole. 

6. Dry the o-rings and teflon crystal holder by either using an aspirator or 
blow them dry with nitrogen. 

NB! Check to be sure that the cleaning agent is chemically compatible with 
the measurement chamber (see the Chemical Compatibility of Viton section 
at the end of this manual). 

4.3.1 Reassembling the Axial Flow Chamber 

After all parts of the measuring chamber and the crystal have been cleaned 
the standard axial flow measuring chamber is reassembled. Please remember 
that cleanliness is very important during the assembly process as the slightest 
contaminations can spoil a measurement. Therefore it is strongly suggested to 
use clean tweezers and laboratory gloves when handling the o-rings, crystal 
holder and the crystal itself as these parts will be in direct contact with the 
sample. The crystal support nut, the crystal support body and the guidance 
pole are not in direct contact with the sample so cleanliness is not as critical. 
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Figure 4.4: The components of the crystal support chamber of the axial flow 
measurement chamber. 
 
Start the assembly process by placing the larger o-ring into the crystal holder.  
 

  
Figures 4.5 and 4.6: Placing the larger o-ring in the crystal holder. 
 
Turn the crystal holder around and place the smaller o-ring in the center of the 
crystal holder. Take the crystal and place it on top of this o-ring so that the 
larger gold electrode faces downward and that the anchor shaped electrode 
points towards the centering hole.  
 

   
Figures 4.7, 4.8 and 4.9: Placing the crystal on the smaller o-ring in the 
crystal holder. 
 
NB! It is very important that the crystal is loaded into the crystal holder as 
described because the larger plated electrode of the quartz crystal has to be 
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grounded when it is in contact with the sample fluid. No successful 
measurements can be performed with the crystal facing the wrong way. 
 
Be careful when handling the crystal, use only tweezers and gently hold the 
crystal from its edges. Do not touch the crystal or the plated electrodes 
directly as this will easily contaminate the crystal which will lead to unstable 
and irreproducible results. If it is necessary to touch the crystal then plastic 
gloves should always be worn. 

The next step in the assembling process is to place the guidance pole in its 
position on the top module and then load the crystal holder with the o-rings 
and the quartz crystal into its position. 

  
Figures 4.10 and 4.11: Placing the guidance pole and the crystal holder back 
into the top module.  
 
Fit the crystal support body with the spring-loaded pins on the crystal so that 
the pins press the crystal against the o-ring and the guidance pole goes 
through the crystal support body. Place the crystal support nut on top of the 
crystal support body and screw it tightly to make the o-ring seal hold. 

  
Figures 4.12 and 4.13: Placing the crystal support body. 
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Figures 4.14 and 4.15: Placing the crystal support nut. 
 
Take the top module of the standard axial flow measuring chamber and place 
it on top of the bottom module. The guidance pole which sticks up from the 
bottom module prevents any false assembly of these two modules, i.e. the top 
module only fits into the bottom module one way. On the bottom of the bottom 
module there are 2 spring-loaded pins which will be in contact with the 
electrodes of the quartz crystal through holes in the crystal support body. 

 
Figure 4.16: Placing the top module back on the bottom module. 
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4.4 Cleaning the Parallel Flow Measuring 
Chamber 

4.4.1 Disassembling the Parallel Flow Chamber 

The measurement chamber usually requires a rinse of the flow system and 
the measuring chamber parts with extensive amounts of ethanol followed by 
ion-exchanged water to be sufficiently clean. However it might be necessary 
to use other liquids for cleaning, and finding the appropriate way of cleaning 
depends largely on the type of experiments so proper cleaning procedures 
develop with experience. 
 
Here is the recommended method for cleaning the parallel flow measuring 
chamber: 

1. Open the lock screw on top of the chamber. Lift the top module 
separate from the bottom module and take it to a sink. Set it down 
upside-down, open the crystal holder by pushing it gently and turning 
anticlockwise. Remove the crystal and the o-ring. 

  
Figures 4.17 and 4.18: Separating the top module of the parallel flow 
measurement chamber. 

2. Set the top module upright again, turn the valve to the Chamber 
position, fill the reservoir with an appropriate cleaning solution and let 
the liquid pass through the flow system. Repeat this for each cleaning 
and rinsing solution (often pure ethanol and ion exchanged water are 
enough) at least 3 times. 

3. Turn the valve to the Stop position and turn the top module of the axial 
flow measuring chamber upside down so that the crystal chamber body 
is upwards. Rinse the inner compartment of the crystal chamber body 
first with the cleaning solution and then with the rinsing solution. 
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4. Dry the flow system and the inner compartment of the crystal chamber 
body either by using an aspirator or by blowing nitrogen through the 
system. 

5. Clean the Viton o-ring with appropriate cleaning and rinsing solutions. 

6. Dry the o-ring by either using an aspirator or blow them dry with 
nitrogen. 

NB! Check to be sure that the cleaning agent is chemically compatible with 
the measurement chamber (see the Chemical Compatibility of Viton section 
at the end of this manual). 

 
Figure 4.19: The removable parts of the chamber: crystal holder, o-ring and 
the crystal. 

4.4.2 Reassembling the Parallel Flow Chamber 

After all parts of the measuring chamber and the crystal have been cleaned 
the parallel flow measuring chamber is reassembled. Please remember that 
cleanliness is very important during the assembly process as the slightest 
contaminations can spoil a measurement. Therefore it is strongly suggested to 
use clean tweezers and laboratory gloves when handling the o-ring and the 
crystal itself as these parts will be in direct contact with the sample. The 
crystal holder is not in direct contact with the sample so cleanliness is not as 
critical. 
 
Start the assembly process by placing the o-ring into the crystal chamber.  
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Figures 4.20 and 4.21: Placing the larger o-ring in the crystal chamber. 
 
Place the crystal on top of the o-ring so that the larger gold electrode faces 
downward and that the anchor shaped electrode is on the left side.  
 

  
Figures 4.22 and 4.23: Placing the crystal on the o-ring in the window 
chamber. 
 
NB! It is very important that the crystal is loaded into the crystal chamber as 
described because the larger plated electrode of the quartz crystal has to be 
grounded when it is in contact with the sample fluid. No successful 
measurements can be performed with the crystal facing the wrong way. 
 
Be careful when handling the crystal, use only tweezers and gently hold the 
crystal from its edges. Do not touch the crystal or the plated electrodes 
directly as this will easily contaminate the crystal which will lead to unstable 
and irreproducible results. If it is necessary to touch the crystal then plastic 
gloves should always be worn. 

The next step in the assembling process is to place crystal holder on top of 
the crystal. The crystal holder fits only in one way. Once the holder is in its 
place push it gently and turn it clockwise. The crystal holder is properly set 
when the electrode holes in the middle are horizontal. 
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Figures 4.24 and 4.25: Placing the crystal holder back into the top module.  
 
Set the top module on top of the bottom module and tighten it with the locking 
screw.  

 
Figure 4.26: The fully assembled and connected parallel QCM ready to use. 
 

The temperature sensor (red cable) is connected to the right side of the 
chamber and the fan power cable (black cable) to the back of the chamber. 
The computer connection is connected to the front of the chamber.  
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4.5 Pre-filling the Temperature Loop 

It is advisable to start the temperature control of the instrument 20 to 30 
minutes before the actual measurement to improve its stability and 
reproducibility. This can be done with the Temperature Control Unit if 
available, but even if not it is important to fill the temperature loop and the 
actual chamber with the background liquid, follow this procedure to do so. 
 

1. Check that the valve is set to Stop and fill the reservoir with the 
background liquid (often water). 

2. Turn the valve to the Bypass setting, wait for a few drops to come out 
and return the valve to the Stop position. Fill the reservoir as 
necessary, no air bubbles should be let into the chamber and thus into 
the tubing.  

3. Turn the valve to the Chamber setting and after a few drops have come 
out turn the valve to Stop.  

4. If a Temperature Control Unit is available set the target temperature 
from the QCM-Z500 Impedance Analyzer program by opening 
Controls > Temperature Controls and selecting the appropriate 
temperature. 

Wait 30 minutes before starting the experiment, use this time to fill in the 
Experimental Setup and otherwise ready the software side of the 
experiment. 

4.5.1 Finalizing the Mechanical Setup 

When all of the parts have been cleaned and the axial flow measurement 
chamber has been assembled check that 

 All of the cables are connected, especially the one connecting the 
measuring chamber to the electronics unit, and that the electronics unit 
is on. 

 If a temperature control unit is present make sure that it is connected to 
the measuring chamber and the computer directly (and not to the main 
electronics unit). 

 The outlet tubes have a waste beaker under them so that the waste 
liquid is collected and disposed of appropriately. 

 The temperature loop is filled with the background liquid, and if a 
Temperature Control Unit is available then it is set to the target 
temperature.  

4.6 The Measurement Process 
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4.6.1 Starting up the QCM-Z500 

When the power of the main electronics unit is turned on, the QCM-Z500 
microbalance starts to boot up the internal Linux computer. A flashing green 
light on the front panel of the unit indicates that the computer is still loading, 
much like starting up a computer takes a few minutes. The booting process 
takes about 1 minute. Do not open the KSV QCM Impedance Analyzer 
software before booting has finished and the green light has stopped flashing 
or the connection cannot be made and the software must be restarted. *** 

4.6.2 Software Overview 

The KSV QCM Impedance Analyzer software has an easy and user-friendly 
interface. Experiments and any other communication between the computer 
and the main electronics unit are conducted from the program labeled QCMZ, 
and the data from previous measurements can be viewed and analysed from 
the program labeled Browse QCMZ. This section of the manual is only 
concerned with taking a measurement, analysing the data is explained in the 
following chapter of this manual, 5. Data Analysis. Once these procedures 
are familiar use the checklist in section 2. Brief Instructions to ensure the 
proper use of the instrument when running experiments.  
 
To start the QCM program double-click the QCM icon on the desktop or 
choose Start > Programs > QCMZ > QCMZ. This will open the main menu of 
the program.  

 

Figure 4.27: The QCM Impedance Analyzer main window. 
 

 Start a New Experiment 

 Experimental Setup 

 Show Sweep Graph 

 Show Graph 

 Show Measurement Controls 
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 Show Temperature Controls 
 
A new experiment is begun from the Start a New Experiment button. This 
opens the Experimental Setup screen which contains the basic identifying 
data of the measurement, like user, resonator type, etc. After that the 
Measurement Controls window along with a Sweep Graph opens.  

The Sweep Graph shows impedance and phase against frequency, the 
normally used Graph shows frequency change against time. A graph of the 
Calculated Results will open on top of the Sweep Graph once an 
experiment is underway with separate Graphs for each harmonic.  

Temperature Controls is only available when a Temperature Control Unit is 
attached, use this to control the temperature of the measuring chamber with 
the computer. Alternatively it can be controlled directly from the Temperature 
Control Unit itself.  

To start a new experiment choose File > New Experiment from the main 
menu window. 

4.6.3 Experimental Setup 

Fill in the information in the Experimental Setup window to comply with the 
measurement. Double-check the Resonator Chamber choice as the 
automatic choice might not always apply, and remember that a calibration 
must be run with each Resonator Chamber separately. For details on 
calibration, please see section 3.3 Calibration. Several fields (like User, 
Resonator Chamber, etc) have a drop-down menu available. To add items 
onto the menu open the Edit Data Base and select the appropriate tab, for 
more details please see the 5.2 Edit Database section of this manual.  
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Figure 4.28:  The Experimental Setup screen. Fill in identifying information on 
the experiment.  
 
Name is the identifying name of the measurement, used to help locate the 
specific experiment later.  
User is the person conducting the measurement.  
Date records the time and date for future reference. It cannot be altered. 
 
By selecting a Resonator (a quartz crystal) all of the required fields are 
automatically filled. If a new Resonator is added fill in the relevant data about 
it into the Database so as to avoid having to fill them in manually each time an 
experiment is run. Information in the Liquid/Gas and the Addition fields are 
for use when analysing the data as well as for reference. 
 
Once all of the required information is filled out press Start to continue.  

4.6.4 Software Control of the Measurement 

When the Experimental Setup has been completed, two windows will open, 
the Measurement Controls window and the Sweep Graph window. The 
Sweep Graph plots impedance and phase against frequency, and once the 
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experiment is begun a Graph of frequency change against time will open on 
top of it. If harmonics are selected they will all be shown on separate graphs. 
The Measurement Controls window controls the measurement chamber, 
how it resonates and what data is sent back to the computer. In most cases 
very little needs to be done in this screen except choosing all of the harmonics 
and pressing Start. 
 

 
Figure 4.29: The Measurement Controls screen. Select measurement setup 
and press Start to begin an experiment. 
 
There is only one measuring Method to choose from by default. This method, 
Automatic, sets the parameters for the measurements (that is, the Resonator, 
Search and Sweep Parameters) to fixed values that have been found to work 
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in most cases for measurements involving a gas, a liquid of either high or low 
density or soft films. 
 
The Resonator, Search and Sweep Parameters cannot be changed when 
using the Automatic method. To change the parameters of the experiment 
create a new Method and fill in the parameters as wanted in the Database. 
From the Edit menu select Database to access it, please see section 5.2 Edit 
Database for details. 
 
What must be determined before the measurement are the Recording 
Options and the Included harmonics (overtones). The harmonics are 
selected by checking the respective box, the measurement data will be more 
complete and easier to analyse with more harmonics so it is advisable that 
they are all chosen.  
 
The Measurement Time should be longer than the experiment is expected to 
last so that all of the interesting phenomenon will be recorded. With AutoSave 
checked the data will automatically be recorded, if unchecked begin and end 
recording with the Rec On and Rec Off buttons. The Rec buttons will only be 
active if AutoSave is not selected. 
 
The software side of beginning the experiment is complete, it is now time to 
ready the chamber for the experiment if this has not yet been finished. 

4.6.5 The Measurement Process 

Check now that all of the steps in 4.2 Preliminaries have been completed. 
This means checking that 
 

 All of the cables are connected and the electronics unit is on. 

 If a temperature control unit is present make sure that it is connected to 
the measuring chamber and to the computer directly (and not to the 
main electronics unit). 

 The outlet tubes have a waste beaker under them so that the waste 
liquid is collected and can be disposed of appropriately. 

 The temperature loop is filled with the background liquid, and if a 
Temperature Control Unit is available then it is set to the target 
temperature.  

When ready begin the experiment by pressing Start. The Sweep Graph 
should now activate and scan for the capacitance of each harmonic 
separately. Once that is finished the Sweep Graph is replaced by the normal 
Graph which by default shows change in frequency against time.  

 



 
 

55 

 
Figure 4.30: Graph of change in frequency against time for all harmonics.  

Once the frequencies have stabilised it is time to introduce the actual sample 
into the chamber. Follow these steps to do so 

 Empty the reservoir and open the Bypass. Let the bypass drain the 
background liquid. 

 Pour the sample liquid into the reservoir. When a few milliliters of the 
sample have come out from the bypass outlet switch the valve to Stop 
and wait a few minutes to ensure thermal equilibrium. 

 Turn the valve to Chamber. Allow a few milliliters to pass through the 
chamber to flush it and then put the valve on Stop.  

 Again wait for the frequencies to stabilise. Flush with the background 
liquid another time or introduce the next sample according to what is 
being measured. Press Stop when finished, obtaining data for the 
measurement is now complete.  

The measurement can be stopped at any time before the chosen 
Measurement Time has been reached by pressing Stop. This action will 
bring up a query of whether to keep the experiment data or not. If the 
measurement data collected so far should be stored in the database for 
further analysis press Yes, but if the measurement data is not useful (for 
example if waiting for frequencies to stabilse before the actual experiment) 
then press No. 
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4.6.6 Useful Tips 

Whenever operating the valve some key points about the working of the 
tubing should be kept in mind. When the sample is a liquid, it is important that 
no air bubbles reach the chamber. Thus whenever something is to be 
introduced to the chamber it must run through the bypass loop first. Also 
whenever anything is flowing out of the reservoir to either the chamber or the 
bypass checks should be kept on the level of the liquid. It should always have 
a few milliliters in reserve.  
 
When changing liquids first empty the reservoir, set the valve to Bypass and 
allow it to empty. Then flush the bypass loop with the new liquid by filling the 
reservoir and allowing the liquid to flow down the bypass for several milliliters. 
It might be necessary to allow more liquid to flow down to clean the tubing.  
 
Whenever changing from the Bypass to the Chamber position or visa versa 
always go by Stop. 
 
The volume of liquid in the bypass loop is slightly above 2 ml, so by careful 
liquid handling it is possible to exchange the liquid in the actual measuring 
chamber with 2 ml of the sample liquid. This can be done by letting a small 
amount of air into the bypass loop and replacing the actual sample liquid with 
a less expensive liquid like water, and then with the help of measuring the 
amount of this substitute water make sure that the air bubble between the 
actual sample liquid and the substitute water never reaches the actual 
measuring chamber. This method however requires careful measuring and 
concentration to be successful. 
 
The Sample Interval in the Recording options box can be reduced to 0.2 
seconds i.e. 5 data points can be collected per second. However, this will 
increase the noise level of the measured signal and should not be used if 
there is not a real need for fast measurements. 
 
To check that everything is working correctly before starting an actual 
measurement it is possible to check the status of the QCM. Start a new 
experiment but do not let any liquid into the chamber, and check what 
resistance is measured across the crystal. The standard 5 MHz gold plated 
quartz crystal when clean and dry has a resistance of about 20 Ohm. Let 
water into the chamber and check the change in frequency. The change from 
air to water should be about -700 Hz. If either of these figures are off then 
there might be a problem with the cleanliness of the crystal, the water or some 
part of the QCM.  
 
To view other graphs during the measurement choose different parameters for 
the x- and y-axis from the drop-down menu at the top of the Graph window. 
An additional curve can be plotted on the same graph by choosing a y2-axis 
parameter, click on the respective button to change the scale.  
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5. Data Analysis and Reduction 

5.1 Overview 

Handling the data obtained by QCM-Z500 microbalance measurements is all 
done with the separate Browse Experiments program. Use it to review data, 
print reports, view and manipulate graphs or to export data to another 
application. A separate Analysis program exists within the Browse 
Experiments screen, the use of which is described in section 5.5 Analysis. 

 

 
Figure 5.1: Use the Browse Experiments screen to locate and analyse 
experiments.  
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5.2 Browse QCMZ Measurements 

Open the QCMZ Brows Experiments by clicking on the icon on the desktop 
or selecting Start > All Programs > QCMZ > QCMZBrowse from the Start 
menu. It can also be found from the installation folder, open My Computer 
and select C:\Program Files\KSV\QcmZBrowse.exe 
 
The main window is split into four boxes. The Experiments box lists all of the 
experiments that are on the database and fit the search criteria inserted in the 
Find Experiment box. The data sent by the QCM of the selected experiment is 
shown in the Original Data box, and if an analysis is run of the experiment 
then the results will be shown in the Sampled Data box. 
 
The menu bar includes these options.  
 
File 

 Search Experiments: adds all of the experiments in the selected folder 
to the Experiments box. 

 Import Experiment: adds a single experiment to the Experiments box. 
 Export Experiments: saves the selected experiment in a specific folder.  
 Make a Copy of Experiment: copies all of the measurement data of the 

selected experiment. 
 Copy Data to Clipboard: copies the data of the highlighted experiment to 

the clipboard for pasting in another program.  
 Print: Opens a Print Preview screen of a report of the experiment 

containing all of the vital information.  
 Remove Experiment from Browser: removes the selected experiment 

from the Experiments box but does not delete the measurement data. 
 Delete Experiment: deletes selected experiment. 
 Exit: Closes the Browse Experiments window. 

 
View 

 Experimental Setup: Opens the Experimental Setup window of the 
highlighted experiment for viewing and editing purposes. 

 Graph: Opens the latest graph viewed, will be blank until some data 
has been graphed. 

 
The icons have the most commonly used functions readily available. 
 

 Print a report of the highlighted experiment. 

 
Copy the Data of the highlighted experiment to the clipboard for 
pasting in another program. 

 
View Experimental Setup window of the highlighted experiment for 
viewing and editing purposes. 

 View the latest Graph opened. 
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The axis of the graph can be chosen directly from the top of the Browse 
Experiments screen using the x- and y-axis selectors. Next item down is the 
Find Experiment box with search parameters that can be filled as far as 
necessary. The search fields limit the experiments visible in the Experiments 
box, select an experiment either by clicking on it or by scrolling with the 
arrows. Double-click on an experiment to display measurement data in the 
Original Data box. Use the tabs to select a specific harmonic. The following 
information about the measurement is shown. 
 
No: Data point identification number. 
Time [s]: Time at which the data point was taken. 
Frequency: The measured frequency. 
Q: The measured Q-value. 
D: The measured dissipation value. 
R: The measured resistance value. 
Cnd: The measured conductivity value. 
L: The measured induction value. 
C: The measured capacitance value. 
Cp:The measured parasitic capacitance value.  
T: The measured temperature. 
T2: The measured temperature from a second probe 
RH: The measured relative humidity.  

5.3 Data Graphing 

The graphs of the Browse Experiments program are very versatile. The 
same graph can show simultaneously two separate variables plotted against a 
third variable for any number of experiments. To view the basic graph, right-
click on an experiment in the Experiments box and select Graph > 
Fundamental or Graph > Nth harmonic where N is replaced by the number 
of the harmonic. 
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Figure 5.2: Graph of change of frequency against time for the third harmonic.  
 
This is the same graph as is open during an experiment, plotting the change 
in frequency against time. To view the frequency change of another 
experiment on the same graph right-click on the experiment and select Add to 
Graph > Fundamental. To view the frequency changes of all of the 
harmonics of an experiment at the same time select Graph > All. To change 
the variable of an axis select a new one from the top of the Browse 
Experiments screen, right-click on an experiment and select Graph. Below is 
an example of all of the harmonics for an experiment. 
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Figure 5.3: Graph of change of frequency against time for the all harmonics. 
 
To alter the data visible the Data Manipulation menu gives the possibility to 
ignore selected data points. The options are to hide data before a selected 
point, after a selected point or between two selected points. Hidden data is not 
considered when running an Analysis. The Data Manipulation menu is also 
used to select sampled data, this is explained below. To select a point double-
click on it.  
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Figure 5.4: Removing data spikes from view to simplify analysis. 
 
After hiding all of the irrelevant spikes (caused by operating the valve) the 
graph looks like this. 
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Figure 5.5: Graph of change of frequency against time for the third harmonic, 
data spikes hidden.  
 
From the Data Manipulation menu this action can be cancelled by clicking 
Undo Hide, or made permanent by clicking Delete Hidden Data Points 
Permanently. 
 
Once a graph is closed it can still be retrieved using the Graph icon on the top 
of the Browse Experiments screen, this brings up the last graph that was 
opened. To alter the display appearance of the graph or to export it select 
from the Graph menu Show Menu.  
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Figure 5.6: The graph Menu can be used to alter the appearance of the graph 
as well as to export the data. 
 
This section features seven tabs: General, Plot, Subsets, Axis, Fonts, Color 
and Style. The tabs have settings ranging from visual aspects of the graph to 
varying the values on the axis, and as most adjustments are familiar from 
other applications they shall not be explained in this manual. There is however 
a help file which can be accessed by clicking Help. 
 
There are two extra buttons on the menu window. Maximize displays a full 
screen version of the graph and Export is used to export data to other 
applications. 
 
An Analysis window can be accessed from the menu which opens when 
right-clicking on an experiment in the Experiments box. This can use the 
normal continuous data or Sampled data, where specific data is selected from 
the graph of the experiment. This uses the Add Sample and the Add Ref 
buttons on the bottom of the graph, and is explained in section 5.5 Analysis. 
 
Below the Experiments box in the Browse Experiments window is the option 
to Normalize graph data. The purpose of normalising is to make the 
harmonics comparable to one another by either multiplying or dividing with the 
chosen variable, either N (number of harmonic) or the square root of N as the 
normalising term. Use N when dealing with a rigid film and square root N 
when dealing with changes in viscosity. Below is a demonstration of how 
normalisation works. 
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Standard 
graph 

 
 

Graph 
normalised by 
N 

 
 
The normalised graph clearly demonstrates that the fundamental frequency 
exhibits curious differences to the other harmonics. It is often recommendable 
to ignore the fundamental in the analysis of QCM measurements. 

5.4 Exporting Data 

Data can be exported either as numbers in a data file or as a graph. The 
easiest way is to click on the Copy Data to Clipboard icon, open a 
spreadsheet program and then paste the data (often from Edit > Paste or by 
pressing Ctrl + V). To export the data in ASCII format click on Copy Data to 
Clipboard, open Notepad (located by default in Start > Programs > 
Accessories > Notepad), paste the data by pressing Ctrl + V in Notepad and 
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save. The lists of experimental data is in the same order as the data in the 
Original Data box in the Browse Experiments screen.  
 

 
Figure 5.7: Pasting data onto Notepad to save it in ASCII format. 
 
The data is tab delimited, for a comma delimited list open the Export menu of 
the graph of the required data. Do so by selecting Graph > Show Menu and 
clicking on Export.  
 

 
Figure 5.8: Export data as an image or text file from the graph Menu's Export 
screen. 
 
Choose Text / Data Only from the top and select whether to place the data on 
the clipboard (for pasting in another program) or to make a .dat file of it. Press 
Export to continue.  
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Figure 5.9: Exporting data as a text file, indicate format styles and press 
Export. 
 
This menu has more specified information on what to export and in what 
format. When finished selecting press Export to continue, either by 
manipulating the .dat file created or pasting the data to another program.  
 
To export the graph as an image use the same screen as shown above. First 
open the desired graph and from the Graph menu select Show Menu and 
then click on Export. The Exporting [Name of Graph] window opens and 
several options as to the image file type are given. Most often JPG will be fine. 
If the image is to be used within a document simply select Clipboard in the 
Export Destination box and Paste the image onto the document. If saving the 
image for later use select File and indicate the folder wanted by clicking 
Browse.  
 
When an image file type is selected the Object Size box is visible, giving 
various options on size restriction methods. The default values should be fine 
in most cases and need not be adjusted.  
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Figure 5.10: Exporting a graph as an image file. Select type, location, size 
and press Export. 
 
Alternatively just use the Export Experiments command in the File menu to 
save the selected experiment in the specified location. This saves the data in 
a format that only another QCMZ Browse Experiments software can read. Use 
this command to transfer measurement data to another computer with QCM 
software.  
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5.5 Analysis 

The Analysis window provides useful tools to investigate QCM-Z500 
microbalance measurements. It can be used to calculate for example the 
thickness of the film on top of the crystal and the viscoelastic properties of the 
sample. Additionally the measured frequency change and resistance can be 
compared to the theoretical values of each harmonic separately, calculated 
from the given experimental data. 
 
Access the Analysis window by right-clicking on an experiment in the 
Experiments box and selecting Analyze.  

5.5.1 Description 

 
Figure 5.11: The Analysis window. Select modeling method, fill in the 
parameters and press Analyze. 
 
The Include harmonics box in the top left corner of the window selects the 
harmonics to be used in the analysis. Often the fundamental includes peculiar 
 phenomena that is not visible in the other harmonics and thus it might 
improve results to leave it out. 
 
Two modeling methods are available, one in which the crystal is covered by a 
rigid film (RF) and a liquid (L) and one in which there is also a viscoelastic film 
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(VF) between the two. The Resonator properties box is filled automatically 
from the Database and thus cannot be altered from this screen.  
 
Use RF+VF+L to observe the rigid and viscoelastic films of liquids.  
Use RF+L to study viscosity changes in liquids or the rigid films in liquids. 
 
The different tabs present different options and properties used in the 
analysis. For more detailed explanation on the differences and the equations 
used please see section 8.3 Theory of Impedance Analysis. Most of the 
fields are filled from the Experimental Setup, others are to be filled with 
known or estimated data.  
 
In each Properties box there are several fields, some which have a faint 
yellow background and can be altered from this screen, some which have a 
white background and need to altered from the database if necessary. To add 
or change a value in these fields access the Database by closing the 
Analysis window, opening the Experimental Setup screen and pressing Edit 
Database. Due to the equations used (see section 8.3 Theory of Impedance 
Analysis for details) some variables can not be fitted simultaneously so a 
choice between two has to be made. Some variables present a choice of 
whether to fit it or not, those not selected for fitting will be considered constant 
and those selected will use the given value as the first term in the modeling. 
 
A) RF + VF + L 
 
In the RF+VF+L tab are three boxes, one for the properties of each layer. 
 
The Initial Liquid/Gas Properties box has two fields, Density and Viscosity, 
which are filled automatically from the data in the Database.  
 
The Liquid Properties box has several fields that can be adjusted from this 
screen. These are the Density, Thickness, G' and either Viscosity or G'' of the 
film. Each variable presents a choice of whether to Fit it or not. Select whether 
to use viscosity or G'' in the model from the top of the box.  
 
The Rigid Film Properties box has two fields that can be adjusted. Those are 
the Density and the Thickness of the film. There is also a choice of whether to 
use that information when modeling or not.  
 
B) RF + L 
 
The RF+L tab is almost the same as the RF+VF+L tab, the main difference 
being the absence of the Viscoelastic Film Properties box. The Liquid 
Properties box has three adjustable fields which are Density, Viscosity and 
Tau. There is also a choice of whether the liquid is Newtonian or Maxwellian.  
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The Rigid Film Properties box has two fields that can be adjusted, the Density 
and the Thickness of the rigid film of which only one can actually be used in 
the fitting.  
 
The View Fit button opens a new window displaying graphs of the harmonics 
individually. The graph displays both the resistance R and the reactance X 
against time, and for both variables a measured value and a calculated value 
are shown. This can be useful to compare the accuracy of the model against 
the experimental data.  
 

 
Figure 5.12: The View Fit screen compares the calculated and measured 
values for each harmonic separately.  
 
The Analyze button runs the modeling program, and the results are displayed 
on the two graphs on the right side of the screen. The Film thickness graph 
simply plots the thickness, in micrometers, of the film on top of the crystal as a 
function of time. The Elastic shear modulus and shear viscosity graph has 
two values, the elasticity in mega Pascals and the viscosity in Pascal seconds 
against time.  

5.5.2 Sampling Data 

Experimental data is imperfect, in the above example changing the position of 
the valve caused spikes in the readings. The way to remove these known 
errors from analysis was to hide them from the graph. Another method which 
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improves the quality of readings and is to be recommended in most cases 
when running an analysis is to sample the data. Note that in experiments with 
a large number of data points (e.g. overnight experiment with a reading taken 
every second) data sampling significantly reduces the time taken to calculate 
an analysis. 
 
Data sampling works by selecting data sets from the graph of a measurement 
of the change in frequency of a harmonic against time. Successive samples 
are taken from an experiment and compared against a reference reading. Two 
alternate methods are available, depending on whether the reference value is 
taken from this experiment or another. If the reference reading can be taken 
from this experiment then first select the reference value (usually from the 
beginning of the experiment) and check that it is designated Sample Number 
0. Then select successive samples with sequential numbering starting from 1 
are taken from the measurement. 
 
If however the reference reading is to be taken from another experiment then 
it must be taken last. Thus first select the samples with sequential numbering 
starting from 1 from the measurement. Then open the measurement from 
which the reference reading is to be taken from and select the reference 
reading, ensuring that it has Sample Number 0. 
 
Samples (and references) are obtained from the graph of a single harmonic at 
times when the frequency has stabilised. Zoom in on the chosen frequency by 
clicking and dragging a box around it. Double-click on the points that mark the 
limit of the data set to select it. The actual recorded sample point is the 
average of all the values between the markers, and it will be automatically 
calculated for all harmonics.   
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Figure 5.13: Sampling data from a graph. 
 
If the reference is taken from the same experiment then select the reference 
data set and click the Add Ref button or selecting Add a Reference to 
Sampled Data from the Data Manipulation menu. This brings up the 
Sampled Data screen. The reference reading must be chosen as number 0, 
which should be displayed automatically. All sample data is then calculated in 
comparison to this reading.   
 

 
Figure 5.14: Sampled Data number selection box.  
 
Press OK to continue. Zoom in on the next stable frequency, the first actual 
sample reading, and select a new data set.  
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Figure 5.15: Sampling data from a graph. 
 
Press the Add Sample button or select Add Selected Points to Sampled 
Data from the Data Manipulation menu. The Sample Number should now 
be 1, click OK and continue until all of the relevant data sets have been 
selected.  
 
Remember that if the reference is to be taken from another experiment then 
the correct order is to first select the data samples, starting from number 1, 
then open the other experiment and select the reference reading with Sample 
Number 0. 
 
To view the sampled data right-click on the name of the experiment in the 
Experiments box of the Browse Experiments screen and from under ---
Sampled Data--- select Graph > Nth harmonic. To then run an analysis of 
this data simply right-click on the name of the experiment and from under ---
Sampled Data--- select Analyze.  
 
For comparison below are several screenshots of the same experiment, on 
the left is the original data and on the right is the sampled data. 
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Original Data 

 
Sampled Data 
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5.5.3 Step-by-Step Guide to Analysing Data 

 If all of the data can be used for analysis, right-click on the experiment 
name and select Analyze. Otherwise select the Sampled Data as 
instructed below. 

 Select the reference frequency either from the same 
measurement as the one for which the sample data will be 
selected from or another experiment run under the same 
conditions. 

 Select the sample sets at each relevant stable frequency. Right-
click on the experiment name and select the Analyze which is 
under Sampled Data. 

 Choose whether to include the viscoelastic film in the analysis, and 
select the appropriate tab. Check that all of the relevant information has 
been included, and if not either fill it in from this window or from the 
Database accessible from the experiment's Experimental Setup 
screen. 

 Select the harmonics to be included in the calculations. Press Analyze. 
The graphs on the right now display the results of the analysis. 

 Press View Fit to view the data and the theoretical value of each 
harmonic separately. 
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6. The Database 
The database stores the library of information the QCM has of possible users, 
liquids and solids. When the Experimental Setup window is open the 
software will reference the information stored in the database to supply the 
choices in the drop-down menus. Use the Edit Database to add, remove or 
alter the information in the database. The database is divided into six tabs: 
Users, Liquids/Gases, Additions, Resonators, Methods and 
Measurement Chambers.  
 

 
Figure 6.1: The Database screen holds all of the information on available 
users and materials.´ 
 
Open the Edit Database window from either the QCM menu bar under Edit > 
Database or from the Experimental Setup screen by clicking Edit Database. 
Each page has a row of buttons near the bottom that can be used for scrolling 
and editing.  
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 Jump to top of list 

 Move one space up 

 Move one space down 

 Jump to bottom of list 

 Add New item to list 

 Delete item from list 

 Edit item on list 

 Post new item entered 

 Cancel edit 

6.1 Users 

In the Users tab a list of current users will appear. To add a new user press 
the New item button, enter the new name in the field space and press Post 
new item. Press OK to continue. 

6.2 Liquids/Gases 

The available names of the fluids are edited like those of users. The additional 
fields give more information about each substance.  
 
Density: Density of fluid 
Viscosity: Viscosity of fluid 

: Surface tension of fluid 
: Dispersive component of surface tension 
: Acid component of surface tension 
: Base component of surface tension 

MW: Molecular weight of fluid 

6.3 Additions 

The available names of the additions are edited like those of users. The 
additional fields give more information about each substance.  
 
Density: Density of addition 
Viscosity: Viscosity of addition 
MW: Molecular weight of addition 
Concentration & Unit: Concentration of component added, include units 

6.4 Resonators 
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The resonator is the quartz crystal. The available names of the resonators are 
edited like those of users. The additional fields give more information about 
each resonator.  
 
In the Resonator box: 
 
Mfgr: Manufacturer of the resonator. 
Freq: Fundamental frequency of the entered resonator. 
Density: Density of quartz, literature value 2.648 g/cm3  
Velocity: Speed of sound in quartz, literature value is 3328 m/s 
m: Stiffness coefficient of the resonator material  
Cpar: Parasitic capacitance for the entered resonator  
Diameter: Diameter of the entered resonator  
Thickness: Thickness of the entered resonator  
 
In the Coating box: 
 
Material: Material of the electrodes on the resonator  
Density: Density of electrode material on the resonator  
m: Stiffness of the electrode material on the resonator  
Area: Active area of the electrode between which the resonator is oscillating. 
Thickness: Thickness of the electrode material on the resonator  

6.5 Methods 

The available names of the methods are edited like those of users. The 
additional fields give more information about each method.  
 
In the Search Parameters box: 
 
Bandwidth: The bandwidth used when searching for the fundamental and 
overtone frequencies at the start of a measurement. 
No of points: Number of points used for plotting the Impedance and Phase 
Shift curves during the search process. 
 
In the Sweep Parameters box: 
 
Bandwidth: The bandwidth used when sweeping around the fundamental 
and overtone frequencies during measurement. If this bandwidth is left at 
zero, the instrument automatically determines a 3 dB wide bandwidth as the 
sweep width for the fundamental and overtone frequencies during the 
measurement. 
No of points: Number of points used for plotting the Impedance and Phase 
Shift curves shown in the sweep graph. Also defines the number of points on 
the Impedance and Phase Shift curves used for fitting the Butterworth-van 
Dyke equivalent circuit model to the data to obtain the electrical components, 
and hence calculate the frequency, Q, and dissipation changes. 
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Allow Edits: Sets permission of changing the Search and Sweep 
Parameters in the MeasControls window for this method. Check to allow 
editing.  

6.6 Measuring Chambers 

The available names of the measuring chambers are edited like those of 
users. Specify a file name where the calibration information for this specific 
chamber will be stored, this file will be created by the program once a 
calibration is run with this chamber. 
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7. Testing and troubleshooting the 
QCM 
Sometimes it is necessary to look at the impedance spectra of the quartz 
crystal and determine if the instrument is working properly, whether it is 
finding the optimum parasitic capacitance Cpar of the crystal and possibly 
altering the instrument setup by hand. 
 
The KSV QCM software is written so that it automatically finds the optimum 
parasitic capacitance for the fundamental and all the chosen overtone 
frequencies. However in problem solving situations looking at the impedance 
spectra and determining the parasitic capacitance can speed up the process 
tremendously.  
 
The background of the parasitic capacitance (procedure also known as the 
electrode capacitance cancellation) is that the total quartz crystal impedance 
includes a parasitic (or shunt) capacitance in parallel with the series resonant 
arm (see figure 7.1 below) of the crystal. This parasitic capacitance origins 
from the capacitance of the crystal electrodes, cables and crystal holder. 
 
The total current through the crystal is the sum of the current through the 
parasitic (shunt) capacitance plus the current through the series resonant arm. 
The physical motion of the crystal is reflected in the values of the L, R and C 
in the series arm of the crystal only, and therefore we want to subtract out or 
otherwise cancel the current through the parasitic (shunt) electrode 
capacitance. By canceling this electrode capacitance we ensure that the 
measured crystal current does not include the current through the electrode 
capacitance and therefore the measured current is essentially the current 
through the series resonant arm of the crystal only i.e. only the changes at the 
electrode surface is detected without any contributions from the instrument 
set-up and connections. 
 

 
Figure 7.1: A circuit equivalent model for the crystal. 
 
In order to test the apparatus first ensure that the instrument is calibrated 
properly and then prepare the instrument as if to conduct an experiment. This 
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means disassembling, cleaning and reassembling the various parts and 
starting up the main electronics unit. Do not fill the instrument with any liquid, 
leave the chamber with air.  
 
Start the QCM measurement program from the Windows Start menu, choose 
Start > Programs > QCM > QCM. From the Controls menu select Test. This 
will open the Test Controls window. 
 

 
Figure 7.2: The Test Controls screen.  
 
Fill in the values as shown above and press Start. The graph that appears 
should have curves similar to those shown below.  
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Figure 7.3: Graph of impedance and phase against frequency.  
 
If the error message No calibration appears then check that the F0 value is 
correctly defined i.e. around 5 000 000 Hz. 
 
If the curves does not look like those shown above try to change the F0 and 
BW parameters in the Sweep parameters box so that it would look as close as 
possible to the above curves. Remember to check that the Cap value is 0 at 
this point.  
 
When this is completed start to increase the Cap value so that it reaches 4-5 
pF, and the Impedance curve changes to a V-shape. Try to obtain as good a 
V-shape as possible.  
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Figure 7.4: Test Controls and graph of impedance and phase against 
frequency.  
 
The obtained Cap value is the capacitance needed to compensate for the 
parasitic capacitance for the specific crystal used at that moment in the 
measuring chamber. This capacitance is usually different when the measuring 
chamber is filled with liquid and can be found in the same way as described 
above.  
 
This test is not necessary for making a measurement, the KSV QCM 
Impedance Analyzer software will automatically determine the parasitic 
capacitances for all of the chosen harmonic frequencies when a measurement 
is started as the Cap values tend to change a little bit at different overtones. 
 
If the Impedance and the Phase Shift do not look as smooth as in the above 
figures, then there might be a problem with the instrument. In such a case 
please contact the nearest KSV distributor (see Appendix: Contacts and 
Support) for further assistance.  
 
When finished with the testing press Stop in the Test Controls window. 
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8. Theory 

8.1 Background 

Pierre and Marie Curie showed in 1880 that crystals of Rochelle salt could 
produce electricity when pressure was applied in certain crystallographic 
directions. Later they also showed the converse effect i.e. production of strain 
by application of electricity. These findings mark the discovery of the 
piezoelectric effect. 
 
Piezoelectricity did not receive a lot of interest in the beginning and a more 
detailed study of piezoelectricity was not started until 1917 when it was shown 
that quartz crystals could be used as transducers and receivers of ultrasound 
in water. In 1919 several devices of everyday interest based on the 
piezoelectricity of Rochelle salt were described, these being loudspeakers, 
microphones and sound pick-ups. In 1921 the first quartz crystal controlled 
oscillator was described. 
 
These first quartz crystal controlled oscillators were based on X-cut crystals 
which have the drawback of being very temperature sensitive. Therefore, the 
X-cut crystals are now used in applications where the large temperature 
coefficient is of little importance, such as transducers in space sonars.  
 
The dominance of the quartz crystal for all kinds of frequency control 
applications started in 1934 when the AT-cut quartz crystal was introduced. 
The advantage of the AT-cut quartz crystal is that it has nearly zero frequency 
drift with temperature around room temperature. From the very beginning of 
using quartz crystal resonators as frequency control elements it was common 
to increase the frequency of the resonator by drawing pencil marks on the 
electrodes and to decrease the frequency by rubbing off some of the electrode 
material with an eraser. 
 
This mass induced frequency shift was only understood on a qualitative basis 
until 1959, when Sauerbrey published a breakthrough paper which showed 
that the frequency shift of a quartz crystal resonator is directly proportional to 
the added mass. Sauerbrey's work is generally taken as the first step towards 
a new quantitative tool to measure very small masses i.e. the quartz crystal 
microbalance (QCM). 
 
Hence, one can describe the QCM to be an ultra-sensitive mass sensor. The 
heart of the QCM is the piezoelectric AT-cut quartz crystal, sandwiched 
between a pair of electrodes. When the electrodes are connected to an 
oscillator and an AC voltage is applied over the electrodes the quart crystal 
starts to oscillate at its resonance frequency due to the piezoelectric effect. 
This oscillation is generally very stable due to the high quality of the oscillation 
(high Q factor). 
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Figure 8.1: The quartz crystal. 
 
If a rigid layer is evenly deposited on one or both of the electrodes the 
resonant frequency will decrease proportionally to the mass of the adsorbed 
layer according to the Sauerbrey equation: 
 

 
Where 

= measured frequency shift 
= resonant frequency of the fundamental mode of the crystal 

= mass change per unit area (g/cm2) 
A = piezoelectrically active area 

= density of quartz, 2.648 g/cm3 
= shear modulus of quartz, 2.947 x 1011 g/cm s2 

 
There are situations where the Sauerbrey equation does not hold, for example 
when the added mass  
A) is not rigidly deposited on the electrode surface(s), 
B) is not deposited evenly on the electrode(s) or 
C) slips on the surface.  
 
Therefore, the Sauerbrey equation is only strictly applicable to uniform, rigid, 
thin-film deposits. Due to this the QCM was for many years just regarded as a 
gas-phase mass detector. Not until the beginning of the 1980´s scientists 
realized that a quartz crystal can be excited to a stable oscillation when it was 
completely immersed in a liquid. Much of the pioneering work in liquid phase 
QCM measurements has been done by Kanazawa and co-workers, who 
showed that the change in resonant frequency of a QCM taken from air into a 
liquid is proportional to the square root of the liquid's density-viscosity product: 
 

 
Where 

= measured frequency shift 
= resonant frequency of the unloaded crystal 
= density of liquid in contact with the crystal 
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= viscosity of liquid in contact with the crystal 
= density of quartz, 2.648 g/cm3 
= shear modulus of quartz, 2.947x1011 g/cm s2 

 
After it was found that excessive viscous loading would not prohibit the use of 
a QCM in liquids and that the response of the QCM is still extremely sensitive 
to mass changes at the solid-liquid interface, QCMs have been used in direct 
contact with liquids and / or viscoelastic films to assess changes in mass and 
viscoelastic properties. Even in air or vacuum (where the damping of layers 
have been considered to be negligible or small) the QCM has been used to 
probe dissipative processes on the quartz crystal. This is especially true for 
soft condensed matters such as thick polymer layers deposited on the quartz 
surface.  

8.2 Applications for QCMs 

A quartz crystal microbalance is basically a mass sensing device with the 
ability to measure very small mass changes on a quartz crystal resonator in 
real-time. The sensitivity of the QCM is approximately 100 times higher than 
an electronic fine balance with a sensitivity of 0.1 mg. This means that a QCM 
is capable of measuring mass changes as small as a fraction of a monolayer 
(single layer of atoms). The high sensitivity and the real-time monitoring of 
mass changes on the sensor crystal make the QCM a very attractive 
technique for a large range of applications. Especially the development of 
QCM systems for use in fluids or with viscoelastic deposits has dramatically 
increased the interest towards this technique. A major advantage of using a 
QCM in liquid analysis is that it allows a label-free (not necessary to add a 
label to the substance) detection of molecules . This also means that it is 
possible to make measurements from samples that are not transparent.  
A partial list of the application areas of the QCM is shown below, and in truth it 
seems that the application areas are only limited by imagination. 
 

 Thin film thickness monitoring in thermal, e-beam, sputtering, 
magnetron, ion and laser deposition. 

 Electrochemistry of interfacial processes at electrode surfaces. 
 Biotechnology 

o Interactions of DNA and RNA with complementary strands 
o Specific recognition of protein ligands by immobilized receptors, 
immunological reactions 
o Detection of virus capsids, bacteria, mammalian cells 
o Adhesion of cells, liposomes and proteins 
o Biocompatibility of surfaces 
o Formation and prevention of formation of biofilms 

 Functionalized surfaces 
o Creation of selective surfaces 
o Lipid membranes 
o Polymer coatings 
o Reactive surfaces 
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o Gas sensors 
o Immunosensors 

 Thin film formation 
o Langmuir and Langmuir-Blodgett films 
o Self-assembled monolayers 
o Polyelectrolyte adsorption 
o Spin coating 
o Bilayer formation 
o Adsorbed monolayers 

 Surfactant research 
o Surfactant interactions with surfaces 
o Effectiveness of surfactants 

 Drug Research 
o Dissolution of polymer coatings 
o Molecular interaction of drugs 
o Cell response to pharmacological substances 
o Drug delivery 

 Liquid plating & etching 
 In situ monitoring of lubricant and petroleum properties 

8.3 Working Principle of KSV's QCM-Z500 

The KSV QCM-Z500 measurement principle is based on the impedance 
analysis of the quartz crystal. This measurement principle means that the 
quartz crystal is not resonating all the time, but the crystal is swept with 
potential perturbations with various frequencies close to the quartz crystal's 
resonant frequency. The potential (U) over the crystal and the electricity (I) 
flowing through the crystal are recorded.  The ratio of U and I then give the 
impedance (Z), and the result of the sweep is the so-called impedance curve 
(the inverse curve is called admittance). 
 
The impedance (or admittance) curve holds all of the information concerning 
the properties of the quartz crystal and the layer deposited on the crystal (see 
figure below). This sweep can be done as a function of time, which enables 
either the measurement of mass changes happening at the quartz crystal 
electrode surface, or only once in steady state case studies. The KSV QCM-
Z500 sweep generator technology is specially designed for QCM applications 
and it enables fast real-time monitoring of adsorption processes and kinetics. 
 
Normally an equivalent circuit model (as shown in below) is fitted to the 
impedance curve and the obtained parameters can be used for calculating the 
resonance frequency and quality factor (Q) or dissipation (D) of the quartz 
crystal (i.e. masses and visco-elastic properties of the deposited layers).  
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Figure 8.2: A circuit equivalent model for the crystal. 
 
The admittance curve displays relevant information on the crystal. The 
broader and lower the admittance curve is the lower the Q-value and the more 
dissipation is taking place. Admittance peaks occur at resonance frequencies.  
 

 

 
Figures 8.3 and 8.4: The crystal in three different environments and the 
admittance against frequency graph for each. 
 
The above admittance curve shows how admittance is affected by a rigidly 
deposited layer or a viscous liquid as compared to air. Additionally the QCM-
Z500 can measure different harmonics of the quartz crystal, which gives 
additional value for determining viscoelastic coefficients of the coating. Due to 
the specially designed sweep generator technology of the QCM-Z500 the 
jump between the different overtones can be made very quickly, and up to the 
11th overtone can be measured for a 5 MHz quartz crystal. 
 
In most cases quartz resonators are integrated to oscillator circuits to form a 
QCM for micro-weighing applications. While this is a cheap and convenient 
way of determining the resonance frequencies of quartz crystals, it will not 
give any information about the quality of the resonance (Q value) which would 



 
 

90 

help for viscoelastic analysis. The advantages of determining the impedance 
(or admittance) curve are: 
 

 Both frequency (f) and quality of resonance (Q factor) or dissipation are 
accessible. 

 Different harmonics can be quickly and sequentially measured. 
 Undesired anomalies including skewed resonance curves or distorted 

resonances due to the interference of anharmonic sidebands are 
directly detected. 

 
 

8.4 Theory of Impedance Analysis 

8.4.1 Electrical Impedance Model 

An unloaded quartz crystal close to its resonating frequency can be modeled 
by the following equivalent circuit. 
 

 
Figure 8.5: The crystal and its equivalent circuit. Unwanted capacitance 
subtracted to calculate impedance. 
 
As introduced in the previous section, the crystal can be considered 
equivalent to an inductor, a capacitor and a resistor in series: the motional 
branch. Parallel to it is a capacitance C0 which is caused by the capacitance 
between the two electrodes that connect to the crystal. Real measurements 
also have some parasitic capacitance (Cpar). Let  

C0* = C0 + Cpar 
 
As the interesting phenomena happen on the motional branch, the effects of 
C0* must be eliminated. The method used is to first determine the value of C0* 
and then adding a capacitor of capacitance -C0* to the circuit. C0 is constant 
but the value of Cpar has to be continuously measured as it changes with 
varying conditions (conductivity of liquid, etc.).  
 
The value for C0 can be determined by  
 
Now the motional branch can be examined. The motional impedance of an 
unperturbed quartz crystal can be calculated with this equation. 
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Where 

, 

and 

is the frequency. 
 
When close to the resonance frequency the following simplification can be 
made. 
 

 
 
Where  is a resonant angular frequency. 
 
If the crystal is loaded then an impedance component caused by the surface 
load must be added to the motional branch model.  
 

  
Figure 8.6: The equivalent circuit of a loaded crystal. 
 
The additional impedance is labeled Zm

0. The total motional impedance is 
then  

 

8.4.2 Converting Electrical Impedance to Mechanical 
Impedance 

The impedances covered above were electrical impedances, that is the values 
measured when investigating the electrical properties of a crystal. Placing a 
load on the crystal surface actually alters the mechanical impedance (Zs). All 
changes in the mechanical impedance are thus actually recorded as changes 
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in the electrical impedance and so must be converted to the mechanical 
impedance. Electrical impedance is directly proportional to mechanical 
impedance, and the exact equation is as follows. 
 

 
Where 

 = Number of harmonic (1,3,5,7,9 or 11) 

 = Electromechanical coupling factor 

 = 2  

 = Fundamental resonance frequency 

 = Parallel capacitance of the crystal 

 = Mechanical impedance of unloaded crystal 

 = 
 

 = Density of quartz 

 = Quartz shear stiffness 
 
As  

 
 
the conversion equation from electrical to mechanical impedance can be 
simplified to the following. 
 

 
 
Let the term zm2ze be used for this coefficient. Thus 

 
and 

 
 
Furthermore the real and complex components of the mechanical impedance 
can be separated into the equations below. 
 

 
 

 
As 
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and 

 
 
the final equations to convert actual measurements (changes in resistance 
and frequency) to the required mechanical impedance are obtained: 
 

 

 

8.4.3 Mechanical Impedances of Various Loads 

A) Rigid layer 
 
With a relatively thin and rigid layer on the surface of the crystal, the surface 
mechanical impedance is given by the equation 
 

 
 
Where  is the mass per area of the layer. 
 
As the impedance has only an imaginary component just acoustic energy is 
stored and no power dissipates.  
 
B) Newtonian fluid 
 
With a Newtonian fluid the surface mechanical impedance is given by the 
equation 

 

 
 
Where 
 

 = fluid density 

 = fluid viscosity 
 
For a Newtonian fluid the dissipated power and energy stored components 
are equivalent.  
 
C) Maxwellian fluid 
 
A Maxwellian fluid is a type of non-Newtonian fluid that considers the finite 
reorientation time of molecules under shear stress. The fluid exhibits a first-
order relaxation process.  
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Where 
 

 = Low-frequency shear viscosity 

 = Relaxation time 
 
Thus the surface mechanical impedance is given by the equation 
 

 
 
D) Viscoelastic layer 
 
With a viscoelastic film of finite thickness the surface mechanical impedance 
is given by the equation 
 

 
Where 
 
G = Complex shear modulus 
G = G'+jG'' 
G' = Storage modulus 
G'' = Loss modulus 

 = Film density 

 = Complex wave propagation constant 

 = 
 

 = Film thickness 

8.4.4 Multiple Layer Combinations 

Usually surface loads on the TSM resonator consist of multiple combinations 
of mass layers, liquids and viscoelastic layers. In such a case, when more 
than one layer is present on top of the quartz interface, the impedances for all 
the layers have to be considered and calculated to obtain the total mechanical 
impedance. In an ideal situation (for example an ideal mass layer on the 
crystal surface between the crystal and a Newtonian fluid) the displacement is 
constant and the impedances are additive. Thus in the example mentioned 
the mechanical impedance would be:  
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This equation is the one used when fitting with the RF+L model. Use it to 
either study viscosity changes in liquids or rigid films in liquids.  
 
In real life this is seldom true and multiple layers do not add algebraically. 
Rather, they combine in nonlinear fashions; the simplest (and most common) 
of which is the case of a finite viscoelastic layer with a Newtonian fluid on top. 
Due to the phase shift across the viscoelastic layer, the total impedance is not 
equal to the to the sum of the characteristic impedances of the individual 
layers.  Instead the surface mechanical impedance is represented by 
 

 
 
To generalise the above equation, here is the formula for the characteristic 
impedance of the nth viscoelastic layer.  
 

 
 
The key to calculating impedances is that the outermost layer of a composite 
resonator is stress free (Zc

(n+1) = 0) or in contact with a semi-infinite fluid. Then 
the surface mechanical impedance can be calculated by working down to the 
resonator/film interface. With an increasing number of parameters 
characterising or extracting the density, thickness and shear moduli would be 
difficult.  
 
When fitting with the RF+VF+L model there are two different ways to handle 
viscoelastic properties: 
 

 Use Viscosity (standard): This model uses the equation G =  + j  , 
where  is the elasticity (G') and is the viscosity.  This is the normal 
method to examine viscoelasticity. 

 Use G'':  This model assumes that G = G' + jG'', where G'' is held 
constant over the measurement frequency range.  This may not be 
valid assumption but sometimes it can be considered to be a constant. 

8.4.5 Optimising Impedance with Harmonics 

In most cases with multiple layers there are several unknown parameters. As 
each harmonic by definition has a distinct frequency different from the others, 
the harmonics also have individual wavelength, attenuation, reflection, phase 
sift, etc. This means that there are as many equations as there are harmonic 
frequencies recorded. 
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The task then is to alter the values of the unknown parameters so as to 
minimize the difference between the measured impedance and the calculated 
impedance (from the model described above) for all harmonics 
simultaneously. For this purpose the Levenberg-Marquardt algorithm is used. 
In practice the steps are the following. 
 

 Obtain measured changes in resistance and frequency for each 
harmonic. (R and f) 

 Calculate recession from frequency. (X) 

 An error term is calculated for each harmonic (i) from the differences 
between the measured and calculated components. The equation used 
is 

 

 
 
The division by N (the number of the harmonic {1,3,5,7,9,11}) is done to 
receive approximately equal weight for each harmonic during 
calculations. 

 
 The Levenberg-Marquardt algorithm tries to minimise all error terms by 

varying selected parameters. The parameters that can be varied are 
those that the mechanical impedance is a function of, namely 
thickness, density, viscosity and elasticity. 

 
The questions that remain for the user are 
 

 Precisely which multiple layer combination is to be used for the model. 
Currently two models are available, rigid film and liquid (RF+L) or rigid 
film, viscoelastic film and liquid (RF+VF+L). 

 Which values to fit. The variables selected for fitting will use the given 
value as the first term in the modeling, and the Levenberg-Marquardt 
algorithm might find a local minimum for one set of parameters and not 
the actual minimum.  

 Which harmonics to include. In many cases the more equations the 
better the answer will be, but the fundamental frequency has a 
tendency to show curious phenomena not necessarily useful for the 
experiment and so should sometimes be left out. Check the View Fit 
screens for different combinations, keeping in mind that three 
harmonics are needed to run the analysis algorithm. 
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9. Technical Specifications and 
Features  

 Impedance analysis 

 Gas and liquid phase measurements 

 High resolution and sensitivity (RMS values of noise level in air and 
liquid is 0.05 Hz and 0.21 Hz, respectively) 

 Direct measurements at air/water interfaces 

 Continuous flow measurements 

 Crystals easily mounted in measuring chamber or crystal holder 

 Flexible choice of surfaces 

 Not fixed to any resonant frequency, crystals in the range 3-55 MHz 
can be used 

 Multi-frequency (quick jumps between overtones) and temperature 
controlled measurements  

 Mass and viscoelastic parameters simultaneously 

 Real time measurements 

 Easy to use Windows based software 

 Straightforward operation 

 Mass sensitivity (5 MHz crystal) 

o  ~ 1 ng/cm2 in air/gas 

o  ~ 5 ng/cm2 in liquid 

 D-factor sensitivity 

o  ~ 2x10-8 in air 

o  ~ 3x10-8 in liquid 

 Max film thickness ~ 5 mm 

 Active sensor area ~ 20 mm2 

 Frequency range 3-55 MHz (can measure up to the 11th overtone of a 
5 MHz crystal) 
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10. Chemical Compatibility of Viton 
Chemical compound  Compatibility  

Acetaldehyde  D- Severe Effect  

Acetate LMW  N/A  

Acetic acid <5%  N/A  

Acetic acid >5%  N/A  

Acetic anhydride  D- Severe Effect  

Acetone  D- Severe Effect  

Acetonitrile  D- Severe Effect  

Acetyl bromide  N/A  

Acetyl chloride  A- Excellent  

Air  A- Excellent  

Aliphatic hydrocarbons  N/A  

Aluminum chloride  A- Excellent  

Aluminum sulfate  A- Excellent  

Alums  N/A  

Ammonia, gas and liquid  D- Severe Effect  

Ammonium acetate  N/A  

Ammonium carbonate  N/A  

Ammonium chloride  A- Excellent  

Ammonium hydroxide  A- Excellent  

Ammonium nitrate  N/A  

Ammonium phosphate  N/A  

Ammonium sulfate  A- Excellent  

Amyl acetate  D- Severe Effect  

Amyl alcohol  A- Excellent  

Amyl chloride  N/A  

Aniline  N/A  

Aniline hydrochloride  D- Severe Effect  

Aqua regia (80% HCl, 20% H)  N/A  

Aromatic hydrocarbons  N/A  

Arsenic salts  N/A  

Barium salts  N/A  

Benzaldehyde  D- Severe Effect  

Benzenesulfonic acid  A- Excellent  

Bleaching liquors  A- Excellent  
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Boric acid  A- Excellent  

Bromine  A- Excellent  

Butane  A- Excellent  

Butanol (butyl alcohol)  A- Excellent  

Butyl acetate  D- Severe Effect  

Butyric acid  N/A  

Calcium oxide  N/A  

Calcium salts  N/A  

Carbon bisulfide  N/A  

Carbon dioxide  A- Excellent  

Carbon tetrachloride  A- Excellent  

Chlorine, dry  A- Excellent  

Chlorine, wet  B- Good  

Chloroacetic acid  D- Severe Effect  

Chlorobenzene  A- Excellent  

Chlorobromomethane  A- Excellent  

Chloroform  A- Excellent  

Chlorosulfonic acid  D- Severe Effect  

Chromic acid, 30%  A- Excellent  

Chromium salts  N/A  

Copper salts  N/A  

Cresol  A- Excellent  

Cyclohexane  A- Excellent  

Cyclohexanone  D- Severe Effect  

Diacetone alcohol  N/A  

Dimethyl formamide  D- Severe Effect  

Essential oils  N/A  

Ethanol (ethyl alcohol)  A- Excellent  

Ether  N/A  

Ethyl acetate  D- Severe Effect  

Ethyl bromide  N/A  

Ethyl chloride  A- Excellent  

Ethylamine  N/A  

Ethylene chlorohydrin  A- Excellent  

Ethylene dichloride  B- Good  

Ethylene glycol  A- Excellent  

Ethylene oxide  D- Severe Effect  

Fatty acids  A- Excellent  
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Ferric chloride  B- Good  

Ferric sulfate  A- Excellent  

Ferrous chloride  N/A  

Ferrous sulfate  N/A  

Fluoboric acid  N/A  

Fluoroborate salts  N/A  

Fluosilicic acid  N/A  

Formaldehyde  D- Severe Effect  

Formic acid  D- Severe Effect  

FREON® TMS  N/A  

Gasoline, high-aromatic  A- Excellent  

Gasoline, nonaromatic  A- Excellent  

Glucose  A- Excellent  

Glue, P.V.A.  A- Excellent  

Glycerin  A- Excellent  

Hydriodic acid  N/A  

Hydrobromic acid, 30%  A- Excellent  

Hydrochloric acid (conc)  B- Good  

Hydrochloric acid (dil)  A- Excellent  

Hydrochloric acid (med)  B- Good  

Hydrocyanic acid  A- Excellent  

Hydrocyanic acid, gas, 10%  A- Excellent  

Hydrofluoric acid, 50%  A- Excellent  

Hydrofluoric acid, 75%  B- Good  

Hydrogen peroxide (dil)  A- Excellent  

Hydrogen peroxide, 90%  N/A  

Hypochlorous acid  A- Excellent  

Iodine solutions  N/A  

Iodoform  N/A  

Kerosene  A- Excellent  

Ketones  N/A  

Lacquer solvents  D- Severe Effect  

Lactic acid  A- Excellent  

Lead acetate  N/A  

Linseed oil  A- Excellent  

Lithium hydroxide  N/A  

Magnesium chloride  A- Excellent  

Magnesium sulfate  A- Excellent  
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Malic acid  A- Excellent  

Manganese salts  N/A  

Mercury salts  N/A  

Methane  A- Excellent  

Methanol (methyl alcohol)  D- Severe Effect  

Methyl chloride  A- Excellent  

Methyl ethyl ketone (MEK)  D- Severe Effect  

Mixed acid (40% H2SO4, 15% HNO3)  N/A  

Molybdenum disulfide  N/A  

Monoethanolamine  D- Severe Effect  

Naphtha  A- Excellent  

Natural gas  N/A  

Nickel salts  N/A  

Nitric acid (conc)  N/A  

Nitric acid (dil)  A- Excellent  

Nitric acid (med)  A- Excellent  

Nitrobenzene  N/A  

Nitrogen oxides  N/A  

Nitrous acid  N/A  

Oils, animal  N/A  

Oils, mineral  A- Excellent  

Oils, vegetable  N/A  

Oleic acid  B- Good  

Oxalic acid, cold  A- Excellent  

Oxygen, gas  N/A  

Palmitic acid  A- Excellent  

Perchloric acid  A- Excellent  

Perchloroethylene  A- Excellent  

Phenol (carbolic acid)  N/A  

Phosphoric acid, 50%  A- Excellent  

Phthalic acid  N/A  

Plating solutions  A- Excellent  

Polyglycol  N/A  

Potassium carbonate  N/A  

Potassium chlorate  N/A  

Potassium hydroxide (conc)  B- Good  

Potassium hydroxide (med)  B- Good  

Potassium iodide  N/A  
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Propanol (propyl alcohol)  B- Good  

Pyridine  D- Severe Effect  

Silicone fluids  N/A  

Silicone oils  A- Excellent  

Silver nitrate  A- Excellent  

Soap solutions  A- Excellent  

Sodium bicarbonate  A- Excellent  

Sodium bisulfate  N/A  

Sodium bisulfite  A- Excellent  

Sodium borate  A- Excellent  

Sodium carbonate  B- Good  

Sodium chlorate  N/A  

Sodium chloride  A- Excellent  

Sodium ferrocyanide  N/A  

Sodium hydrosulfite  N/A  

Sodium hydroxide (conc)  B- Good  

Sodium hydroxide (dil)  B- Good  

Sodium hydroxide, 25%  B- Good  

Sodium hypochlorite, <5%  A- Excellent  

Sodium hypochlorite, >5%  B- Good  

Sodium nitrate  N/A  

Sodium silicate  A- Excellent  

Sodium sulfide  N/A  

Sodium sulfite  N/A  

Steam, up to 40 psi  B- Good  

Stearic acid  N/A  

Styrene  A- Excellent  

Sulfuric acid (conc)  A- Excellent  

Sulfuric acid (dil)  A- Excellent  

Sulfuric acid (med)  A- Excellent  

Sulfurous acid  A- Excellent  

Tannic acid  N/A  

Tanning liquors  N/A  

Tartaric acid  A- Excellent  

Tin salts  N/A  

Toluene (toluol)  A- Excellent  

Trichloroacetic acid  C- Fair  

Trichloroethylene  A- Excellent  
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Trisodium phosphate  A- Excellent  

Turpentine  A- Excellent  

Urea  N/A  

Uric acid  N/A  

Water, fresh  A- Excellent  

Water, salt  A- Excellent  

Xylene  A- Excellent  

Zinc chloride  A- Excellent  
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11. Example Measurements Made 
with the QCM-Z500 

11.1 Solutions of Different W-% of Glycerol 

As the QCM-Z500 uses impedance analysis it is highly suitable for operation 
under heavy viscous loading. The standard measuring chamber supports 
operation in either gas or liquid environments, and provides single-electrode 
exposure to liquids (a prerequisite for compatibility with electrochemical QCM 
measurements). Figure 11.1 shows the frequency change of polished, gold 
coated 5 and 10 MHz crystals in contact with different glycerol solutions 
measured with the QCM-Z500. The tight correspondence between theory and 
experimental results is clearly illustrated. Figures 11.3 and 11.4 on the other 
hand show the admittance phase and admittance magnitude of a polished, 
gold coated 10 MHz crystal from which the data in figure 11.1 was calculated. 
The results prove that the QCM-Z500 is an excellent tool for the evaluation of 
fluid properties. 
 

 
Figure 11.1: Change in frequency against glycerol weight percentage (in 
water) as measured with the QCM-Z500 (circles and squares) and predicted 
by theory (dashed lines) for two different quartz crystals with different 
fundamental resonance frequency.  
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Figures 11.2 and 11.3: Admittance Magnitude and Admittance Phase of a 
polished, gold coated 10 MHz crystal in contact with different glycerol 
solutions measured with the QCM-Z500. 

11.2 Rigid Film Deposition 

Anything that has a mass can generate a response from a QCM sensor. The 
universal response of the device is the reason for the wide range of 
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application of the technology. The use of the QCM technique as a thickness 
monitoring device in different metal evaporation and sputtering applications is 
widely known. In the same way the QCM can be used to monitor the 
deposition of precisely defined rigid layers such as for example Langmuir-
Blodgett films.  
 
Figure 11.4 below shows the ex situ frequency change measured in air with 
the QCM-Z500 instrument after depositing stearic acid monolayers on both 
sides of a 5 MHz quartz crystal. The frequency change of the same crystal 
was measured after each deposition process by placing the same crystal into 
the standard QCM-Z500 measuring chamber and recording the frequency of 
the crystal in air. The monolayers were deposited on the quartz crystal with a 
KSV Minitrough 2 film balance from a MnCl2 subphase at a constant surface 
pressure of 30 mN/m. 
 

 
Figure 11.4: Frequency change at different overtones measured ex situ in air 
induced by deposition of Stearic acid monolayers on the quartz crystal. 
 
By taking the area per stearic acid molecule measured from the Langmuir 
compression isotherm (20 Å2/molecule), the active electrode area on the 
quartz crystal (19.63 mm2) and the average molecular weight (343.5 g/mol for 
the stearic acid–manganese complex when 50 % of the stearic acid 
monolayer is undissociated as in this case), the Sauerbrey equation predicts 
that 1 stearic acid monolayer deposited on both sides of the quartz crystal 
should induce a 32.2 Hz change in frequency. Figure 11.5 below shows how 
well the predicted and the measured frequency change correlate with each 
other. The measured frequency change is plotted as the blue dotted line as an 
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average of the normalized frequencies of all the overtones shown in figure 8.4 
and the predicted frequency change is shown as open squares.  

 
Figure 11.5: The predicted and measured frequency change as a function of 
number of deposited monolayers on the quartz crystal. The standard deviation 
for the average between the different overtones is also shown.  

11.3 Alternate Adsorption of Oppositely 
Charged Macromolecules 

The assembly of ultrathin films containing biological macromolecules, 
polymers, nanoparticles and other compounds has attracted a lot of interest 
during the last 3 decades due to their potential applications. The methods 
usually used for preparing these ultrathin films are spin coating, solution 
casting, thermal deposition, self-assembly or the Langmuir-Blodgett 
technique. However, during the last decade a new way of preparing ultrathin 
films has been extensively studied, and that is layer-by-layer assembly of 
polyions. This technique makes use of the alternate adsorption of oppositely 
charged linear or branched macromolecules (for example negatively and 
positively charged polymers, nanoparticles and proteins). The technique is 
very simple and provides the means to form ultrathin films of various 
substances. 
 
Figure 11.6 shows an example of an in situ layer-by-layer assembly build-up 
of oppositely charged macromolecules studied with the QCM-Z500. The 
polyelectrolytes used in the study shown in figure 11.7 were hyaluronic acid 
and chitosan dissolved in a solution containing 0.15 M NaCl with a pH of 4.5. 
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It is worthwhile to notice that it was possible to measure up to the 11th 
overtone of a 5 MHz crystal, which is enabled by the propriety design of the 
flow through measuring cell and the use of impedance analysis of the crystal. 

 
Figure 11.6: Frequency change at multiple overtones of a 5 MHz crystal 
induced by alternate adsorption of 9 (HA/CHI) double layers plus a last 
deposition of a HA layer i.e. in total 19 layers. 
 
Figure 11.7 shows the normalized frequencies calculated from all overtones in 
figure 11.6. It can clearly be seen that the data correlates well with each other, 
and as there is no large dependence of - f/n with the overtones (n) the 
Sauerbrey relation should hold to a good approximation. This exponential 
character of the HA/CHI buildup process has also been demonstrated in 
literature, for example Langmuir, Vol. 20, No. 2, 2004 p. 448. However, in that 
study the frequency changes for the complete buildup process of 20 layers 
was only reported for the fundamental and 5th overtone frequencies. One 
reason for this could be that they did not use the impedance analysis 
technique as was used for the measurement in figure 11.6. above, which also 
serves as a good example of the power of using the impedance analysis for 
QCM measurements as it enables the measurements on very highly 
dampened systems.  
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Figure 11.7: Normalized frequencies calculated from all overtones in figure 
11.6 for the buildup process of HA/CHI multilayers. 
 
Although the results in figure 11.7 demonstrate the validity of Sauerbrey 
relation, looking at the dissipation changes for the same buildup process 
actually indicates that the layers deposited after the 7th (HA/CHI) bilayer are 
not so well connected to the surface of the quartz crystal as one would expect 
from figure 11.7. This is shown in figure 11.8 below. One explanation for this 
could be that before the 7th (HA/CHI) bilayer the buildup process of the 
multilayer is happening in small patches rather than in an homogeneous film, 
while after the 7th (HA/CHI) bilayer the mulitlayer forms a homogenous film 
leading to a situation where the outer layers of the multilayer are not so well 
coupled to the quartz surface. 
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Figure 11.8: Dissipation changes at multiple overtones of a 5 MHz crystal 
induced by alternate adsorption of HA and CHI. 

11.4 Protein Adsorption 

Anything that has a mass can generate a response from a QCM sensor. The 
universal response of the device is the reason for the wide range of 
application of the technology. The use of QCM has dramatically increased in 
recent years in the field of biotechnology. The QCM is routinely used to obtain 
information about for example protein adsorption / desorption, cell adhesion, 
protein-protein interaction, degradation of polymers, biofouling and biofilm 
formation, drug analysis and DNA Biosensors. 
 
Figure 11.9 show measurements adsorption of the protein Human Serum 
Albumin (HSA) to 5 MHz quartz crystals treated to have different properties. 
Measurements were performed with the QCM-Z500 standard measuring 
chamber. The frequency changes of 83, 39 and 36 Hz for the Hydrophobic 
Au, Hydrophilic Au and LB layer surfaces, respectively, are in good agreement 
with a protein adsorption study to differently treated silica made with an in situ 
ellipsometer (reference 17). The table below shows the comparison between 
the results with the QCM-Z500 and the ellipsometer study. The tight 
correspondence between the results is clearly illustrated. 
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Figure 11.9: Frequency changes during adsorption of HSA to 5 MHz crystals 
with different properties. 
 
Adsorbed amounts of HSA at different surfaces. 
Surface Adsorbed amounts of 

HSA determined with 
QCM-Z500 

Adsorbed amounts of 
HSA from reference 17 

Hydrofobic 0.73 mg/m2 0.80 mg/m2 
Hydrofilic 0.34 mg/m2 0.35 mg/m2 
PC LB layer 0.32 mg/m2 0.30 mg/m2 

11.5 Signal to Noise Ratio Example 

The mounting of the quartz crystal into the measuring chamber is a very 
critical issue for not damping the quartz crystal too much, which on the other 
hand can affect the noise level and consequently the sensitivity during the 
measurement. Due to KSV Instruments' proprietary electronic design, 
measuring chamber design and software algorithms the noise level of the 
QCM-Z500 instrument is equal or even better than with the “pinging principle” 
used by some other manufacturers, this even at the maximum acquisition 
speed. This is illustrated by the measurement below. The frequency of the 
crystal was first monitored in air, after which a buffer solution was introduced 
into the measuring chamber.  
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Figure 11.10: Monitoring frequency changes with the QCM-Z500 of a 5 MHz 
crystal before and after introducing a buffer solution into the measuring 
chamber. 
 
The sections marked A and B in figure 11.10 were chosen to be expanded for 
looking at the noise level. One can clearly see that the noise level is very low 
for both air (see figure 11.11 A) and the buffer solution (see figure 11.11 B). 
The calculated RMS values of the noise level for air and the buffer solution 
are 0.05 Hz and 0.21 Hz, respectively. 
 
 

  
Figure 11.11 A Figure 11.11 B 
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12. Electrochemical chamber QCM 

12.1 Overview 

The electrochemical chamber QCM (EQCM) is a modification to the parallel 
flow measurement chamber that enables the insitu study of electrochemical 
polymerization reactions. In particular it allows the observation of change in 
mass against change in ionic charge.  

12.2 Converting to the EQCM 

Lift the top module separate from the bottom module and remove the crystal 
holder, crystal and o-ring according to the instructions in section 4.4.1 
Disassembling the Parallel Flow Chamber. Open the black glass holder by 
turning it anticlockwise and gently remove the round glass window and the 
large o-ring. Remove the four locking screws. 
 

 
Figure 12.1:  The top module with crystal holder, crystal, glass holder, glass 
window, both o-rings and the first screw removed.  
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The aluminum chamber support stage can now be removed from the top 
cover. Lift the metal chamber up from its slot. 
 

 
Figure 12.2: The chamber support stage with the metal chamber lifted up. 
 
Hold the chamber inlet tube in place and turn the metal chamber clockwise to 
detach it. Attach the bottom part of the EQCM chamber to the chamber inlet 
tube. 
 

 
Figure 12.3: The EQCM chamber attached to the chamber inlet tube.  
 
Place the chamber into its slot and place the top module cover onto the 
chamber support stage. Attach the lock screws and the black glass holder. 
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Figure 12.4: The bottom part of the EQCM chamber attached to the top 
module. 
 
Note that the EQCM does not use the glass window or the large o-ring that 
the parallel chamber does. Also note that the chamber outlet is from the top 
part of the EQCM chamber, and not from the top module.  
 

 

 
Figures 12.5 and 12.6: The top part of the EQCM chamber and the entire 
EQCM chamber attached to the top module.  
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12.3 EQCM Measurement 

12.3.1 Preparation 

The crystal is placed inside the chamber in the same way as with the parallel 
flow chamber. Lift the top module and remove the white crystal holder to get 
to the crystal, see section 4.4.1 Disassembling the Parallel Flow Chamber 
for details. When the crystal has been cleaned and placed inside the crystal 
chamber reattach the top module to the bottom module with the locking screw.  
 
Push the reference electrode gently trough the top part of the electrochemical 
chamber. The platinum counter electrode is fixed to the top part and does not 
need to be attached separately. Push the top part gently in to the middle of 
the bottom part of the electrochemical chamber. 
 
Connecting the potentiostat to the QCM chamber depends on the experiment 
setup. This example is for a 3-electrode system. The counter electrode (CE) is 
connected to one of the platinum electrode poles. It does not matter which 
pole is used.  
 

 
Figure 12.7: The counter electrode connected to a platinum electrode. 
 
The reference electrode (RE) is connected to the end of the electrode wire. 
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Figure 12.8: The reference electrode connected to the end of the electrode 
wire. 
 
The working electrode (WE) and the sense electrode (S) are connected 
straight to the bottom module. 
 

 
Figure 12.9: The working electrode and the sense electrode connected to the 
bottom module. 

12.3.2 Measurement 
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Start the QCM software. Select Device Parameters from the Edit menu. 
Activate the potentiostat by checking Potentiostat Enabled and press OK 
button. 
 

 
Figure 12.10: Activating the potentiostat from the Device Parameters window. 
 
Open the Ivium software and press the Connect button in the left upper 
corner. The Ivium software has to be connected to the potentiostat before the 
QCM control is connected. Once the Ivium software is connected, open the 
Potentiostat Controls window in the KSV QCM software, and press the 
Connect button. When the Don’t record before start option is checked the 
QCM software does not record data points before measurement is started 
from the potentiostat software. The Voltage and Current fields are blank 
unless a measurement from the potentiostat is running. An error 
announcement will appear while pressing the Connect button if the Ivium 
software is not connected to the potentiostat. If no announcements appear the 
QCM measurement can be stated.  
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Figure 12.11: The EQCM can be activated by pressing the Connect button. 
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13. - Contact Information 
If any problems arise please feel free to contact a local distributor or KSV 
Instruments directly.  
 
KSV Instruments can be contacted from this address: 
 

KSV Instruments Ltd. 
Höyläämötie 7 
FIN-00380 Helsinki 
Finland 
Tel. +358-(0)9-5497 3300 
Fax +358-(0)9-5497 3333 
E-mail info@ksvltd.fi for sales and  

support@ksvltd.fi for service or technical questions 
http://www.ksvltd.com 

 
Listed in alphabetical order by country name, our distributors are: 
 
Abu Dhabi, Alain, Bahrain, Oman, Saudi Arabia, Qatar, United Arab 
Emirates 

 
Deira General Marketing 
DGM-LAB Division 
P.O.Box No: 11370 
Plot No: 236, Next to Ace Hardware 
Sheik Zayed Road 
Dubai, United Arab Emirates 
Contact:Mr. H.B. Vincent 
Tel: +971 4 3389111 
Fax: +971 4 3382625 
E-mail:dgmlab@emirates.net.ae 
http://www.dgm.com 

 
 
Australia, New Zealand  
 

Scientific Solutions 
PO Box 4033 
Caloundra DC 
Queensland, 4551 
Australia 
Contact: Mr. Phillip Harrip, Managing Director 
Tel: +61-7-5438-2222 
Fax: +61-7-5438-2233 
E-mail: pharrip@scisol.com.au 
           http://www.scisol.com.au 

mailto:info@ksvltd.fi
mailto:support@ksvltd.fi
http://www.ksvltd.com
mailto:E-mail:dgmlab@emirates.net.ae
http://www.dgm.com
mailto:pharrip@scisol.com.au
http://www.scisol.com.au
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Austria, Germany and Switzerland 
 

L.O.T. Oriel GmbH 
Im Tiefen See 58 
D-64293 Darmstadt 
Germany 
Contact: Dr. Thomas Wagner 
Tel.+49-6151-880 668 
Fax +49-6151-896 667 
E-mail: Wagner@LOT-Oriel.de 
           http://www.LOT-oriel.de 

                                                           
 
Benelux: The Netherlands, Belgium, Luxembourg 
 

Technex  B.V. 
Industrieweg 35 
1521 ne Wormerveer 
The Netherlands 
Contact: Mr. Doeke-Jan van der Meulen 
Tel. +31-(0)75 647 4567 
Fax +31-(0)75 621 3663 
E-mail: d-j.vd.meulen@technex.nl 
           http://www.technex.nl 
           http://www.oppervlaktespanning.nl 

 
Brazil  
 

Lazuly Comércio Consultoria e Servicos Ltda. 
Rua Doutor Satamini, 292 / 218 
Tijuca - Rio de Janeiro 
CEP: 20270-231 
Brazil 
Contact: Ms. Alcione Chagas Ribeiro 
Tel. / Fax.+55-21-25022159 
E-mail: lazuly@lazuly.org 
           http://www.lazuly.org 

 
 

mailto:Wagner@LOT-Oriel.de
http://www.LOT-oriel.de
mailto:d-j.vd.meulen@technex.nl
http://www.technex.nl
http://www.oppervlaktespanning.nl
mailto:lazuly@lazuly.org
http://www.lazuly.org


 
 

123 

China 
 

Beijing Honoprof Sci & Tech Ltd 
Room 210, Shenggu Building A3, Shenggu Bei Road 
Chaoyang District, Beijing 100029 
China 
Contacts: Mr.Stephen Liu 
          Ms. Katerine Qing 
Tel. +86-10-64415767 / 64426982    
Fax +86-10-64425485 
E-mail: info@honoprof.com            
           http://www.honoprof.com 

              
 
Denmark, Norway 
 

Danalytic ApS 
Hoejagervej 33 
DK-8700 Horsens 
Denmark 
Contact: Mr.Bent Hansen 
Tel. +45-7565 5055 office 
       +45-4015 2055 mobile 
Fax +45-7565 8517 
E-mail: danalytic@post.tele.dk 

 
 
Finland 
 

KSV Instruments Ltd  
Höyläämötie 7 
00380 Helsinki 
Finland 
Contact: Dr. Tapani Viitala or Mr. Sauli Törmälä 
Tel.+358-9-54973300 
Fax +358-9-54973333 
E-mail: tviitala@ksvltd.fi or sauli.tormala@ksvltd.fi 
           http://www.ksvltd.com 

 
 

mailto:info@honoprof.com
http://www.honoprof.com
mailto:danalytic@post.tele.dk
mailto:tviitala@ksvltd.fi
mailto:sauli.tormala@ksvltd.fi
http://www.ksvltd.com
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France 
 

Sodexim S.A. 
10, rue du Grand Pré / Z.I. 
51140 Muizon 
France 
Contact: Mr. Hubert Puttemans 
Tel. +33-(0)3-2602-9111 
Fax +33-(0)3-2602-9400 
E-mail: sodexim@easynet.fr 
           http://www.sodexim.com 

 
 
Greece, Bulgaria, Cyprus, Albania, Macedonia 
 

Anti-Sel Selidis Bros 
35 Anaximandrou 
6 Fleming Street 
Harilaou 
54250 Thessaloniki 
Greece 
Contact: Mr. Theodoros Selidis 
            Mr. Dimitris Dedoussis 
Tel. +30-31-322 525 
Fax +30-31-321 912 
E-mail: antisel@antisel.gr 
           http://www.antisel.gr 
 
 

India 
 
Specialise Instruments Marketing Company 
18th Forth View, Sion East, Rd. No.1 
Scheme 6 
Mumbai-400022 
India 
Contact: Franklin D´Souza 
Tel. +91-22-402 5529, 407 1989 
Fax +91-22-402 1360  
E-mail: specmcof@vsnl.net 
           http://www.specialiseinstruments.com 
                                                        

 

mailto:sodexim@easynet.fr
http://www.sodexim.com
mailto:antisel@antisel.gr
http://www.antisel.gr
mailto:specmcof@vsnl.net
http://www.specialiseinstruments.com
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Iran 
 

Samamicro 
22 Khorramshahr, ST, (Apadana) 
P.O. Box: 19395-1485 
Tehran - Iran 
Contact: Mr. M.A. Ghasemi 
Tel. +98-21-8765011 - 16 
Fax +98-21-8765010 
E-mail: info@samamicro.com 
           http://www.samamicro.com 

                                                           
 
 Italy  
 

Nordtest s.r.l. 
Via Liverno 11 
I-15069 Serravalle (S) 
Italy 
Contact: Dr. Maurizio Bruni or Dr. Vania Armani 
Tel. +39-0143-62422 
Fax +39-0143-65517 
E-mail: mbruni@nordtest.it 
           http://www.nordtest.it 

         
                                               
Japan 
 

ALTECH Co., Ltd 
YM Shinjuku BLDG.4-1 Yotsuya 
4-chome, Shinjuku-ku 
Tokyo 160-0004 
Japan 
Contact: Mr. H. Sato 
Tel. +81-(0)3-5363-3004 
Fax +81-(0)3-5363-0944  
E-mail: h-satoh@altech.co.jp 
            http://www.ksv.jp 

 
                                                 

mailto:info@samamicro.com
http://www.samamicro.com
mailto:mbruni@nordtest.it
http://www.nordtest.it
mailto:h-satoh@altech.co.jp
http://www.ksv.jp
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Korea 
 

Chang-Kyung Enterprise Corp. 
Room 202, Golden BLDG. 
256-5, Yangjae-Dong 
Seocho-Gu, Seoul, 137-130 
Korea 
Contact: Mr. K.M. Ahn 
Tel. +82-2-578 4796/7 
Fax +82-2-3463 3296 
E-mail: kmahn@korea.com 
           http://www.changkyung.co.kr 

                                                             
 
Malaysia 
 

KULIM HI-TECH Sdn. Bhd. 
Unit 527, 5th. Floor 
Brunsfield Business Center 
No. 3. Jln. Yoga 13/42, Section 13 
40100, Shah Alam 
Selangor, MALAYSIA 
Contact: Mr. Abdul Rahman Azaham 
            Mr. Mahathir Jamail 
Tel. 603-5519 5433 / 603-5519 8487 
Fax 603-5513 2831 / 603-5191 2139 
E-mail: azaham@tm.net.my 

                                                              
 
Romania 
 

Sepadin Prodexport S.R.L. 
62, Tunari Street 
bl. 24D 
sc. A, et. 4, ap. 19 
72121 Bucharest 
Romania 
Contact: Mr. Nicolae Dinu   
Fax +40-1-2110795 
E-mail: office@sepadin.ro 

                                                             
 

mailto:kmahn@korea.com
http://www.changkyung.co.kr
mailto:azaham@tm.net.my
mailto:office@sepadin.ro


 
 

127 

Singapore  
 

Analytical Technologies PTE Ltd 
Blk 12, Lorong Bakar Batu, #06-09 
Kolam Ayer Industrial Estate 
Singapore 348745 
Contacts: Mr. Richard K.W. Yue 
             Ms. Koh Pek Hoon 
             Ms. Hwee-Leng Tan 
Tel. +65-6746 8068 
Fax +65-6746 0661 
E-mail: singapore@analytical-online.com 
           http://www.analytical-online.com 

 
         
Spain  
 

Iberlaser S.A. 
Avda. Pirineos 7 Oficina 2-8b 
28700 San Sebastián de los Reyes 
Madrid 
Spain 
Contact: Ms. Paloma González González 
             Mr. Armando Izquierdo 
Tel. +34 91 658 67 60 
Fax. +34 91 654 17 00 
E-mail: pgonzalez@iberlaser.com  
           aizquierdo@iberlaser.com  
           http://www.iberlaser.com 

                            
 
Sweden  
 

KSV-Jenser AB 
Johannesfredsvägen 5 
SE-16869  Bromma 
Sweden 
Contact: Mr. Johan Granath (lab. products) 
            Mr. Carl Bohman (ind. products) 
Tel. +46-8-6629966 
Fax +46-8-366266 
E-mail: johan.granath@ksv-jenser.se and carl.bohman@ksv-jenser.se 
          http://www.ksv-jenser.se 

 
 

mailto:singapore@analytical-online.com
http://www.analytical-online.com
mailto:pgonzalez@iberlaser.com
mailto:aizquierdo@iberlaser.com
http://www.iberlaser.com
mailto:johan.granath@ksv-jenser.se
mailto:carl.bohman@ksv-jenser.se
http://www.ksv-jenser.se
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Taiwan 
 

San King Technology Co., Ltd. 
7th Floor, 112. Sec. 1 
Chung Hsiao East Road 
10023 Taipei 
Taiwan R.O.C. 
Contact: Mr. Tommy K.D. Huang 
             Mr. Yung Chin Lee 
             Mr. Alan Chen 
Tel +886-2-2358 2668 
Fax +886-2-2358 3312   
E-mail: sanking8@ms29.hinet.net 

                                                             
 
Turkey 
 

Terralab 
74.Sok.No:14/9 Ovecler 
06460 Ankara 
Turkey 
Contact: Mr. Bulent Atamer 
Tel. +90 312 472 73 96-97 
Fax +90 312 472 73 98 
E-mail: bulent-atamer@terralab.com.tr 
           http://www.terralab.com.tr 

                                                              
 
United Kingdom  
 

L.O.T. Oriel Ltd 
1 Mole Business Park 
Leatherhead 
Surrey 
KT22 7BA 
U.K. 
Contact: Ms. Roslyn Rivers 
Tel. +44-1372-378 822 
Fax +44-1372-375 353 
E-mail: Roslyn@lotoriel.co.uk 
           http://lot-oriel.com/uk 

 
                                                              

mailto:sanking8@ms29.hinet.net
mailto:bulent-atamer@terralab.com.tr
http://www.terralab.com.tr
mailto:Roslyn@lotoriel.co.uk
http://lot-oriel.com/uk
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U.S.A., Canada, Mexico 
 

KSV Instruments, Inc. 
P.O.Box 192 
Monroe, CT 06468 
U.S.A. 
Contact: Mr. Greg Wills 
Tel. +1-203-268 1745 or 1-800-280 6216 (toll free) 
Fax +1-203-459-0437 
E-mail ksvinfo@aol.com  

 
 
 

mailto:ksvinfo@aol.com

